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About This Manual

This manual provides the details of programming and operating Honeywell SLG700 SmartLine Level

Transmitters for applications involving HART® versions 5, 6, and 7 communication protocols. For
installation, wiring, and maintenance information refer to the SLG700 SmartLine Level Transmitter
User Manual, Document # 34-SL-25-11.

The configuration of your Transmitter depends on the mode of operation and the options selected for it
with respect to operating controls, displays and mechanical installation. Details for operations involving
the Honeywell Multi-Communication (MC) Toolkit (MCT404) are provided only to the extent necessary
to accomplish the tasks-at-hand. Refer to the associated MCT404 User Manual for complete details.
The “Reference” section in the front matter of this manual lists document titles and numbers.

The SLG700 SmartLine Level transmitter can be digitally integrated with one of two systems:

e Experion PKS: you will need to supplement the information in this document with the data
and procedures in the Experion Knowledge Builder.

o Honeywell’s Total Plant Solutions (TPS): you will need to supplement the information in this
document with the data in the PM/APM SmartLine Transmitter Integration Manual, which is
supplied with the TDC 3000 book set. (TPS is the evolution of the TDC 3000).

Release Information

Rev. 1.0, April 2015 — First release

Rev. 2.0, July 2015 — Security Vulnerability section added

Rev. 3.0, June 2016 — Updates for R101 release. Including SLG726.

Rev. 4.0, December 2016 — Basic Transmitter added (R102)

Rev. 5.0 February 2017 - Full tank detection information updated (R102_FF)

Rev. 6.0 December 2017 — R200 release which implemented the Saturated Steam and

Low DC Applications and FEP-coated probes.
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Patent Notice
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1 Introduction

1.1 Overview

The SLG700 SmartLine Level Transmitter is available for operation with HART® version 7

communication. This manual addresses the processes to configure a Transmitter for HART®
communication.

1.1.1 HART® Mode Communication

As indicated in Figure 1, the output of a transmitter configured for HART® protocol includes two
primary modes:

e Point-to-Point Mode: where one Transmitter is connected via a two-conductor,
4-20 mA current loop to one receiver.

e Multi-Drop Mode: where multiple Transmitters are connected through a two-
conductor network to a multiplexed receiver device.

( < A00 ™ URL -
—_— 7 \
__3..5350 20 MA ——————— > "FVEUHI'

\ =3 300 Communications
Operating] | — 27§ 5 (Digital AC) i
Range of 250 y | 100% PV <=>PVv
; Ly ey Analog DC)
Transmitter 200 s I of Pange (/
(in “implied” EU; | [[==175 pan
Example: - 160 (Process Rangs)
oa00inem! (2122 0 || # s 0%
‘ —T5 of Range \-
= \ 4mA {—>'PVEULO" |
\ 0 LRL . . . /
HART "Point-Point” Mode
4 LRV +roraninsmismiesmminisnsesimonsaniiarae |}UR'U)<:> “PVEUHI N
Span Dighal PV, PV
/- Digital Commnunications

TRV - _*hw-( = (LR > "BVEULO
\ 4 mA (spprox.)

HART * ‘Multi-Drop™ Mode

Figure 1: HART Point-to-Point and Multi-drop Value Scaling

In point-to-point mode, the value of the Primary Variable (PV) is represented by a 4-20 mA current
loop, almost identical to that of a Transmitter operating in analog mode. In this case, however, the
analog signal is modulated by Frequency Shift Keying (FSK), using frequencies and current
amplitude that do not affect analog sensing at the receiver. FSK modulation is for sending digital
messages in addition to the analog value. The accuracy of the analog level must be precisely
controlled for accurate sensing. HART communication will not bump process variables.

In multi-drop mode, theoretically up to 16 devices in HART 5 (addresses 0-15) or up to 64 devices
in HART6/7 (addresses 0-63) can exist on the two-conductor network. Practically, the number of
devices in a multi-drop installation is limited due to design constraints. When installing into a multi-
drop network, consider that the SLG700 requires a minimum startup current of 17 mA and a
minimum terminal voltage of 11 V during startup. After this initial startup period (approximately 0.5
seconds), the loop current will be fixed at 4 mA, and the minimum terminal voltage is 14 V. The
power source, wiring, intrinsic safety barriers, and other devices in the network must also be
considered.
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Transmitters with HART capability have features that vary among manufacturers and with the
characteristics of specific devices. The FDC software application executing on the MCT404
supports the HART Universal, Common Practice and Device Specific Commands which are
implemented in the Honeywell Transmitters.

1.2 Making Transmitter Adjustments

Zero and Span adjustments are possible in new generation SLG700 SmartLine Level Transmitters
by using the optional three-button assembly located at the top of the Electronic Housing.
However, certain capabilities are limited in the following configurations:

e Without a display — Zero and Span setting only for HART devices.

e With a display — Display supports configuration of basic parameters. Complete
transmitter configuration is possible only with DD and DTM.

You can also use the Honeywell MCT404 Configuration Tool to make any adjustments to an
SLG700 Transmitter. The MCT404 tool has two applications; MC Toolkit (MCT) and Field Device
Configurator (FDC).

Using the FDC application, you can adjust the SLG700 HART model configuration.

Certain adjustments can also be made through the Experion Station if the Transmitter is digitally
integrated with a Honeywell Experion System.

SLG700 HART models can be configured using Honeywell tools such as Experion in conjunction
with FDM, using DTMs running in FDM or PACTware, or Emerson 375 or 475.

1.2.1 Local Display Options
The SLG700 Level Transmitter offers the Advanced Display; see Table 1 for a list of features.

Table 1 - Available Display Characteristics

e 360° rotation in 90° increments
e Three (3) configurable screen formats:
— Large process variable (PV)
— PV with bar graph
— PV with trend (1-999 hours, configurable)
o FEight (8) screens 3-30 seconds configurable rotation timing
Advanced e Standard and custom engineering units
Display o Diagnostic alerts and diagnostic messaging
e Multiple language support:
— Western pack contains: English, French, German, Spanish,
Turkish, Italian and Russian
— Eastern pack contains: English, Chinese and Japanese
e Supports optional 3-Button configuration and HART calibration
e Supports transmitter messaging and maintenance mode indication

Page 2 SLG700 Series HART Option User’'s Manual Revision 6



2 Configuration Tools and Interfaces

2.1 Overview

This section describes the tools and interfaces involved in configuring a new SLG700 SmartLine

Level Transmitter for HART® communication operation. The information in this section also applies
to adjusting the configuration of a Transmitter that has been in operation and updating one that is
currently in operation.

2.1.1 Prerequisites

The information and procedures in this manual are based on the assumption that personnel
performing configuration and calibration tasks are fully qualified and knowledgeable in the use of
the Honeywell MC Toolkit or MCT404. The name MC Toolkit or Toolkit and MCT404 are used
interchangeably as MCT404 is the model name for the Honeywell MC Toolkit product.

& When using MCT404,before connecting to a HART transmitter, verify that the Field
Device Configurator (FDC) application is used and not the MC Toolkit application. When
you use the MC Toolkit application, the MCT404 is set for DE communications, where the
current amplitude can bump process variables in either point-to-point or in the multi-drop
mode in HART.

Furthermore, we assume that the reader is intimately familiar with the SLG700 family of SmartLine
Level Transmitters and thoroughly experienced in the type of process application targeted for
Transmitter deployment. Therefore, detailed procedures are supplied only in so far as necessary
to ensure satisfactory completion of configuration tasks.

2.1.2 MC Toolkit

ﬂ Before using the MC Toolkit, be sure that you are aware of the potential
consequences of each procedure, and that you use appropriate safeguards to avoid
possible problems. For example, if the Transmitter is an element in a control loop, the
loop needs to be put in manual mode, and alarms and interlocks (i.e., trips) need to be
disabled, as appropriate, before starting a procedure.

2.1.3 MC Toolkit (MCT404) Software Applications

The MC Toolkit (handheld) has two software applications to work with SLG700 SmartLine Level
Transmitters:

e Field Device Configurator (FDC). This application is used for configuring,
calibrating, monitoring, and diagnosing HART devices. FDC conforms to the IEC
61804-3 EDDL (Electronic Data Description Language) standard specification. The
FDC application is an open solution that supports devices with a registered device
description (DD) file compatible with HART Communication Foundation (HCF)
requirements.
e MC Toolkit (application). This application is used for configuring, calibrating,
monitoring, and diagnosing Honeywell Digitally Enhanced (DE) devices. Honeywell
SmartLine Level transmitters do not support the DE protocol at present.
Details for working with the MC Toolkit are provided in the MC Toolkit User Manual, Document #
34-ST-25-50. In subsequent sections of this manual, explicit operating instructions are provided
only in so far as necessary to complete required tasks and procedures.
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2.1.4 Configuration Databases
The MC Toolkit is used to establish and/or change selected operating parameters in a Transmitter
database.

2.1.5 Configuration

Configuration can be accomplished both online and offline with the Transmitter powered up and
connected to the MC Toolkit. Online configuration immediately changes the Transmitter operating
parameters. For Offline configuration, Offline files created using Honeywell FDM Tool can be
imported into FDC application and then can be downloaded to the Transmitter.

ﬂ When you set up or configure a Transmitter, it can take up to 30 seconds for the
value to be stored in it. If you change a value and Transmitter power is interrupted before
the change is copied to nonvolatile memory, the changed value will not be moved to
nonvolatile memory.

2.1.6 MC Toolkit-Transmitter Electrical/Signal Connections
Resistor values apply to SLG700 Level transmitters only. Refer to SLG700 Transmitter User’s
manual, #34-SL-25-11, for acceptable power supply and RL ranges.

©

/' MC Toolkit
(MCT404)

Figure 2: MC Toolkit-Transmitter Electrical/Signal Connections

2.1.7 DTM

The DTM is a Device Type Manager following the FDT specification and can be installed for use
by any application that acts as an FDT compliant host container. Of which PACTware is just one.

See section 7.
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3 Transmitter Configuration

3.1 Using the Field Device Communicator (FDC)

Each new SLG700 Level Transmitter configured for HART protocol is shipped from the factory
configured as ordered to meet customer requirements. No reconfiguring should be necessary,
however if changes are desired then this section assumes that the user will use the Field Device
Communicator (FDC) application for HART configuration tasks. The FDC application provides the
facilities for the online and offline configuration of Transmitters operating with HART protocol.

Online configuration requires that the Transmitter and MC Toolkit are connected and
communication between the two has been established. Online configuration provides a set of
functions with which to perform various operations on a HART communication network through an
active communication link. These operations primarily include configuration, calibration,
monitoring, and diagnostics. Typically, these operations could be realized through various
constructs exposed by the Device Description (DD) file. In addition, the FDC application provides
some functions for convenient execution of these functions.

Offline Configuration refers to configuring a device when the device is not physically present or
communicating with the application. This process enables the user to create and save a
configuration for a device, even when the device is not there physically. Later when the device
becomes available with live communication, the same configuration can be downloaded to the
device. This feature enables the user to save on device commissioning time and even helps the
user to replicate the configuration in multiplicity of devices with lesser efforts. Currently, FDC does
not support creating offline configuration. However, it supports importing of offline configuration
from FDM R310 or later versions. The configurations thus imported can be downloaded to the
device from FDC.

The following are the tasks that the user needs to perform for importing offline configuration in
FDC application software and then downloading it to the device.

e Create offline configuration template in FDM

e Save the configuration in FDM in FDM format.
¢ Import the offline configuration in FDC

e Download the offline configuration to the device

For details on creating and using offline configuration, refer to

Note: section Offline configuration in FDM User’s Guide.

3.1.1 Personnel Requirements

The information and procedures in this section are based on the assumption that the person
accomplishing configuration tasks is fully qualified and knowledgeable on the use of the MC
Toolkit and is intimately familiar with the SLG700 family of SmartLine Level Transmitters.
Therefore, detailed procedures are supplied only in so far as necessary to ensure satisfactory
configuration.
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3.2 Overview of FDC Homepage

The FDC homepage consists of links for Online Configuration, Offline Configuration, Manage DDs,
and Settings. See below.

Field Device Configurator

ﬁ? 5—» 5 |

Online Offline
Configuration Configuration
AT T
il o5y
7l :_—_|] ., -
(6 B | Cl\\‘a- i
Manage DDs Settings

e T - )

Figure 3: FDC Homepage

Table 2 lists the items that appear on the FDC homepage and its descriptions.

Table 2 - FDC homepage elements

=
©
3
0

Description

Screen title.

Tap to quit FDC.

Tap to view the application information.

Tap to navigate to Online Configuration screen.

Tap to navigate to Offline configuration screen.

Tap to navigate to Manage DDs screen.

Tap to navigate to Settings screen.

Tap to select the highlighted menu option.

(o oy Sl oy ST =

Tap to quit FDC.

then tap Select or double-tap the option.

To select an option in FDC the user can either select the option
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3.2.1 Settings

Use this feature to customize FDC. The user can customize FDC for device detection, DD
selection, and other application settings.

Device Identification
Use the following options to configure FDC to identify a device.

e Using Poll Address

— Use poll address 0 only: Use this to detect a device with the poll address as
zero.

— Find first poll address and use: Use this to detect a device with the first
available poll address in the range of poll addresses that are available.

— Use selected poll address: Use this to detect a device with a specific poll
address in the range of zero to 63.

— Use From: Use this to detect a device based on a range of poll addresses.

e Using Device TAG: Use this to detect a device with a known HART tag.

e Using Device LONG TAG: Use this to detect a device with a known HART long tag
(applicable for devices with HART 6 or later Universal revisions).

If the user chooses the Using Device TAG or Using Device
Note: LONG TAG, the FDC prompts the user to enter a device tag/long
tag name during device detection.

DD selection

e Use the following options to configure FDC to select DD files when a DD with
matching device revision is not available.

— Use DD file of previous device revision: Use this option to automatically
communicate using a DD file having device revision lower than that of the
device.

— Use generic DD file: Use this option to automatically communicate to the
device using an appropriate generic DD file.

— Always ask user: Use this option to always prompt the user with a choice for
communicating to the device either using the previous device revision or using
a generic DD file.

— Always Use Generic: Use this option to always communicate to the device
using generic DD files even if a DD file with matching device revision as the
device is present.

A generic DD file is a DD file that provides access and interface to

Note: the universal data and features of a HART device.
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Other settings
Low storage notification: Use this option to set a percentage value and to notify the user with a
warning message when the available storage card space is less than the percentage set.

Application diagnostics: Use this option to enable or disable the logging infrastructure for
application diagnostics. With this option enabled, FDC creates necessary log files for
troubleshooting and diagnostics. These files are stored in SD Card\FDC folder.

The user must not enable this option unless suggested by Honeywell

Note: TAC because this may impact the application performance.

3.2.2 Manage DDs

Using this feature, the user can manage the DD files installed with FDC. A DD file contains
descriptive information about the functionality of a device. By default, a set of DD files are installed
with FDC. However, if you do not have a DD for a given device, the user can install it using the
“Add DD” feature. Similarly, the user can uninstall a DD file or a set of DD files using “Delete DD”
feature. The user can also directly copy the DD files in appropriate hierarchy using a card reader
or “Active Sync/Mobile Device Center” mechanisms. In such a case, the user should validate the
library view using the “Refresh” feature.

Overview

Using Manage DDs, the user can view, add, or delete DD files for devices. A list of already
available DD files is maintained in the DD Library. FDC lists the installed DD files in a hierarchy as
below:

e Manufacturer
o Device Type
e DevRev xx, DDRev yy

e DevRev pp, DDRev qq

Add a DD file
To add a DD file for a device, perform the following steps.

1. From the FDC homepage, tap Manage DDs > Select.
The Manage DDs dialog box appears.

2. Tap Options > Add DD.
Or

|'-.- -.H.I
Tap ¥
The ADD DD files dialog box appears.
3. Browse to the location in which the DD file (.fm8) is located and tap OK.
4. If the DD file already exists, then the following message appears.
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File already exists, Do ol
waht to overwrite the
existing 0D file?

Yes

Mo

5. Tap Yes to overwrite the existing DD files.

6. If the DD file is successfully added, a success message appears.

Delete a DD file

Using this option, the user can delete a particular version of a DD file. To delete a DD file for a

device, perform the following steps.

e From the FDC homepage, tap Manage DDs > Select.

The Manage DDs dialog box appears.

e The user can choose to delete DD(s) in one of the following ways:

a) By device manufacturer — Select a device manufacturer to delete all device types

and DDs associated with the manufacturer’s devices.

b) By device type — Select a device type to delete all DDs associated with the device.

c) By device revision and DD revision — Select the specific entry of device revision,
DD revision to delete the specific DD

e Tap Options > Delete DD.
Or

Tap a

A confirmation message appears.
e Tap Yes.

If the DD file is deleted successfully, a success message appears.

e Tap OK to return to DD Library page.

Validating a manually edited library

Besides using the Add/Delete DD features, advanced users may also manipulate a DD library by
directly editing the contents of the FDC\Library folder. DD files can also be transferred directly to
this location by connecting the MCT to a PC. In such cases, the user must perform the following

steps to validate a DD Library, thus edited manually:

1. From the FDC homepage, tap Manage DDs > Select

The Manage DDs dialog box appears
2. Tap Options.
3. Tap Refresh Library.
Or

1. Tap ﬁ

2. A confirmation message appears.

4. Tap Yes. The DD library is now validated and refreshed.
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3.2.3 Online configuration

Using online configuration, you can configure, calibrate, monitor and diagnose a HART device
which is connected to MC Toolkit. FDC provides the features to perform these functions through
the various constructs offered through the DD file of the device. Besides there are certain other
features available under this link for you to conveniently work with a HART device with live
communication. After making changes to the device the user can also save a snapshot of the
device data as history to later transfer it to FDM for record and audit purposes.

3.2.4 Offline configuration

Offline configuration refers to configuring a device offline (without physically connecting to the
device) using a template and then downloading the configuration to the device. Presently, FDC
application software does not support creating offline configuration. However, it supports importing
of offline configuration from FDM (R310 and above).

3.2.5 Online Configuration Overview

Online Configuration option provides the user a set of functions with which they can perform
various operations on a device with an active communication link. These operations primarily
include configuration, calibration, monitoring, and diagnostics of a HART device. Typically, these
operations could be realized through various constructs exposed by the DD file of the device. In
addition, FDC also provides some additional application functions for the user to perform these
functions more conveniently.

Online configuration includes a set of functions to perform various operations on a Transmitter with
active communication link. These operations primarily include:

e |dentifying a Transmitter

e Reading and reviewing Transmitter variable values

e Editing Transmitter variable values

¢ Downloading the selected/edited variable set to the Transmitter

Detecting and loading a device
Tap the Online Configuration button on the Application Home page.

The device detection and loading process automatically gets started. Depending upon the Device
Detection and DD Selection settings the user may have chosen, the user may be prompted for
certain inputs as described in the Settings section.
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3.2.6 Overview of Device Homepage

Once the device is detected and loaded successfully, the user can view the device homepage for
the identified device.

The workspace area on the device homepage consists of 4 tabs on the left hand side. Selecting a
tab displays functions/information associated with that tab on the right hand side.

Figure 4: Device Homepage

Table 3 lists the device health status and their indications.

Table 3 - Device health status

Device health icons Indications

e Indicates there’s no health or status indicators
reported by the device

O Indicates that the device is potentially reporting a

status which needs attention and further
investigation. It is advised that the user use
Device Status under Functions tab to further
investigate the details.

5T Indicates that the device has lost communication
= with MC Toolkit
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3.2.7 Tabs on the Device Home page

The following are the options that are available on the device homepage.

Information tab: Use this option to view the device identity related information. The user can view
the manufacturer name, device type, device revision, DD revision, and universal revision of the

HART device.

Functions tab: This tab provides various options which the user may use for navigating through
the device specific user interface and some standard features offered by FDC across all devices.
For the sake of explanations, the right side options under this tab shall be referred as “Entry

points” throughout the rest of the document.

Iungtag

Taols

Select

EE“ Device Status

! | | |

Process Monitoring

My Device

Device Status

Methods List

Return
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My Views tab: Quite often, the user may be interested only in a set of variables of a device.
But navigating through the menu tree of a device may not be helpful because of time and
further all variables that the user want may not be in the same location. Using this unique
feature of FDC, the user can now choose what they want to view in a device in your own
views. FDC allows the user to create two such views per device revision of a specific device
type. The user can always modify them as per your needs.

g Iungtag

Functions

Select Return

Tools tab: This tab is a placeholder for FDC specific tools for providing certain functionality.
Currently the only option it provides is called as Save History. Using this option you can save
the snapshot of the device variables. This snapshot is saved in a format which can be later
imported as a history record in FDM.

iy longtag

Select Return
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3.2.8 Using FDC for various device operations

Typical operations with a smart field device involve configuration, monitoring, and diagnostics.
FDC enables the user to achieve these operations with a HART device via the various
interfaces/constructs exposed through the DD file of the device.

The “Functions” tab under the device home page provides the entry points for navigating through
the device specific user interface to perform the above mentioned operations. A device may define
up to four entry points in the DD file. All devices shall have at least one entry point, generally
referred to as “Online”. Besides the device specific entry points, FDC provides custom entry points
for navigational aids to specific types of information/features. One such entry point is called Device
Status, which is used for reviewing device health. Another is called Methods List, which is used to
navigate to all the methods available in a device.

All of the device specific entry points represent the device interface, as explained using the Online
entry point as an example. All the other device specific entry points have a similar interface except
for the fact that the variables and other DD constructs provided under each may vary as indicated

by the title of each entry point.

ﬂ For the sake of explanation, the pages that appear on navigating through the
device specific entry points are referred to as “Device Configuration” pages in this
document. However it must be noted that this does not prohibit the user from
performing other device operations as explained above.

Online Device Entry Point: When the user tap on to open the Online tab, the device configuration
screen appears as shown below.

i Online

\—|li] Device Setup
-@ Basic Configuration
-@ Advanced Configuration
-Q Monitor

+Send
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Alternately the user can access the full EDDL features by selecting the My Device Tab

5 My Device |i®i'x

—| ] My Device
E| Device setup
- [
- Advanced Configuration
- Monitor

Label IVaIue | Unit I

Navigate through the menus to access various functions. See section 3.2.9 page 16 for a complete
listing of all the parameters and details.
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3.2.9 Device Configuration and Parameter Descriptions

Below are descriptions of all parameters for a HART Transmitter with the Online tab menu path.
The same parameters may be accessed via the Shortcuts menu under the My Device tab.

Parameters are grouped under the following headings.

Basic configuration (see Table 4)

- General

- Process

- Measurement

- Dynamic Variables
- 4-20 mA Outputs
- Summary

Advanced Configuration (see Table 5)

- Mounting

- Probe

- Linearization*

- Volume*

- Correlation Algorithm
- Services

- Local Display

- Summary

Monitor (see Table 6)
- Dashboard
- Device Status
- Device Information
- Echo Curve
- Adv Diagnostics

* The Linearization and Strapping tables may not work with AMS system
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Table 4 - Basic Configuration parameters

Key: Plain=Readonly Bold = Configurable  Bold underline = Method Bold italic = Table or graph
General

Tag Enter Tag ID name up to 8 characters long.

Long Tag Enter Tag ID name up to 32 characters long.

Length Unit m Select the unit for all length related parameters.

cm
mm
in
ft

Temperature Unit °C Select the unit for all Temperature related parameters.

°F

Volume Unit liter Select the unit for all volume related parameters.

ft3
in3
US gal
imp gal
bbl(liq)
yd3
m3
bbl
Velocity Unit ft/s Select the unit for all Velocity (rate) related
m/s parameters.
in/min
m/h
ft/min
in/s

Date Gregorian calendar date that is stored in the Field
Device. This date can be used by the user in any way.

Descriptor Enter any desired or useful descriptor of the
transmitter.

Message Enter a message up to 32 alphanumeric characters)
that will be sent to the Display. The message will be
shown on the Display interspersed with the configured
screens.

Clear message Select to clear message from transmitter’s local
display.

Final assembly num Used for identify electronic components.
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Table 4 - Basic Configuration parameters, cont’d

Key: Plain = Read only

Bold = Configurable

Bold underline = Method

Bold italic = Table or graph

Process

Measured Products

Single Liquid

Two Liquids, Flooded

Two Liquids, Non- Flooded
Saturated Steam

Single Liquid, Low DC

Select measured product.

Meas. Prod. Ref. Image.

Provides the image based on configured
measured product.

@
-

Product

®
A

Upper Product

Lower Product

Single Liquid Two Liquids Flooded
@ ®

Upper Product

Lower Product

Two Liquids Non-Flooded Saturated

Steam

Config. DC Param.

Vapor DC
Product DC
Upper Prod DC
Lower Prod DC

Select dielectric constant (DC) values for
measured product. A drop-down list of
typical products and their DCs is provided.

Lower Prod DC

Upper Prod DC

For single liquid, this is Product DC.

Vapor DC

Max. Filling Rate

Enter Maximum filling/emptying speed.

Measurement

Sensor Height

See Ain image

Max. Product Level

See B in image

Level Offset

See C in image

Measurement Range
Details Image

®

100%

'Irmllp
+ €3

Probe Length

Enter probe length.
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Table 4 - Basic Configuration parameters, cont’d

Key: Plain=Readonly Bold = Configurable = Bold underline = Method Bold italic = Table or graph

Dynamic Variables

Measured Products Single Liquid, Selected product being measured.

(Read only) Two Liquids Flooded IMPORTANT: If the user changes the
Two Liquids Non-Flooded Measured Product after configuring Dynamic
Saturated Steam Variables, always check that dynamic
Single Liquid, Low DC variables configuration corresponds to the

new Measured Product. (For example, an
error will be generated if PV is Intf Level
while Measured Product is Single Liquid.)

Config. Dynamic Var.

PV (Primary Variable and Product Level Four dynamic variables PV, SV, TV, and QV
loop current) can each be configured to monitor a different
Product Level % device variable. These 4 dynamic variables
SV (Secondary Variable) . and their live measured values will be
Distance To Product displayed under the Monitor tab.
TV (Tertiary variable
( Y ) Product Level Rate Note: The device variables available to PV,
QV (Quaternary variable) Vapor Thickness SV, TV and QV will vary according to the
measured products. For example, Dist to Intf
Vapor Thickness % will not be available for a single liquid. Also,
the volume-related device variables are
Interface Level available only if the volume calculation
method has been configured (page Error!
Interface Level % Bookmark not defined.). Always check
. configuration after changing Measured
Distance To Interface Product configuration.

Interface Level Rate IMPORTANT: The PV primary variable is

the process variable that controls the loop
output, whereas the SV, TV and QV are
monitored only.

Upper Product
Thickness

Product Volume . .
For more details on abbreviations used

Vapor Volume please refer to DD help files.
Lower Product Volume

Upper Product Volume

PVis PV’s assigned variable.
SVis SV’s assigned variable.
TVis TV’s assigned variable.
QVis QV’s assigned variable.
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Table 4 - Basic Configuration parameters, cont’d

Key: Plain = Read only

Bold = Configurable

Bold underline = Method Bold italic = Table or graph

4-20 mA Outputs

PV Levels Image

PV Ranges / Limits

Upper Stress Limit (USL) o,
Upper Transducer Limit (UTL) [

Upper Range Value (URV) = == s

Lower Range Value (LRV) == ===

Lower Transducer Limit (LTL) e

C
Lower Stress Limit (LSL) |

A = User Range, B = Device Range,
C = Device in Stress

PV URV

Enter the measured PV upper range value
for which the analog output will be scaled
to 20 mA.

PV LRV

Enter the measured PV lower range value
for which the analog output will be scaled
to 4 mA.

PV Damp

Enter number of seconds damping time
applied to the analog output.

PV % rnge

PV’s value expressed as % of range.

PV Loop current

PV’s loop current (4-20 mA).

PV Alrm typ

Defines the loop current value when
device detects critical fault.

Hi: Loop current is set to more than

21 mA

Low: Loop current is set to less than
3.6 mA.

Loop current mode

Enable: Enables loop current mode
(analog output will operate as a

4 to 20 mA signal consistent with the
transmitter output).

Disable: Disables loop current mode
(analog output will be fixed to value set by
user).

Poll addr

Address used by the Host to identify a
Field Device, and changeable by the User
to control: the Multidrop Mode for Analog
Output 1), and the Analog Output Fixed
Mode of Analog Output 1).

Num req preams

Number of request preambles required
from the Host request by the Field Device
for Synchronization.

Echo Lost Timeout

Enter number of seconds. In case of Echo
is lost (peaks are not detected), device
waits for configured timeout to report fault.
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Table 4 - Basic Configuration parameters, cont’d

Key: Plain = Read only

Bold = Configurable  Bold underline = Method Bold italic = Table or graph

Latching mode

Determines behavior in the event of a
critical error.

Latching: The transmitter will stay in the
critical error state until the user performs a
hardware or software reset.
Non-Latching: The transmitter will leave
the critical error state automatically, after
the circumstances leading to the critical
state cease to exist.

NAMUR output

Enabled: High saturation current value set
to 20.5.
Disabled: High saturation current value set
to 20.8.

Summary
Summary Shows important basic configuration
parameters.
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Table 5 - Advanced Configuration parameters

Table 5 - Advanced Configuration parameters, cont’d

Key: Plain = Read only

Bold = Configurable  Bold underline = Method Bold italic = Table or graph

Mounting

Transmitter Model

SLG720: Standard

(Read only) SLG726: High Temperature & High Pressure
Process Connection Type Threaded
(Read only) Flanged
Sensor Connection Direct
(Read only) Remote
Mounting Location Tank
Bracket
Nozzle Nozzle Height
Nozzle Diameter
Bypass/standpipe Bypass/Standpipe Height
Bypass/Standpipe Diameter
Stillwell Stillwell Height
Stillwell Diameter
Mounting Angle In Degrees
Full Tank Detection Disabled Enabled: Detection of product at top of
Enabled flange.
Background Type Built-in Built-in: Use default factory loaded
Field background for noise cancellation
Obstacle Field: Use captured field background for
noise cancellation in the process connection
area.
Obstacle: Use captured obstacle
background potentially up to probe end for
noise cancellation.
Dynamic background OFF This feature provides enhanced immunity
ON against changes in measurement conditions
by dynamically adjusting the active Field or
Obstacle background profile. This feature is
not applicable for the Factory background.
When enabled, the sensor periodically
schedules automatic updates to the
background echo profile."

Start Capture This will initiate capture of a new background echo
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Table 5 - Advanced Configuration parameters, cont’d

Key: Plain = Read only

Bold = Configurable  Bold underline = Method Bold italic = Table or graph

Probe

Config. Probe

Probe Type

Custom

Rod

Wire

Coax

Multi Twist Wire
PTFE Rod
PTFE Wire

Probe Diameter

Custom
4mm
6mm
7mm
8mm
12mm
16mm
22mm
42mm

Probe End Type

None
Clamp
Weight
Loop

Centering Disk Type

Custom

316/316L Stainless Steel
PTFE

C-276 Nickel Alloy

Probe material

Custom

316/316L Stainless Steel
PFA coated stainless steel
C-276 Nickel Alloy

Centering Disk Diameter

2 inches
3inches
4 inches
6 inches
8 inches

Probe Propagation Factor

09to 1.1

Probe Length

Refer to SLG700 Transmitter User’s manual #34-SL-25-11
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Table 5 - Advanced Configuration parameters, cont’d

Key: Plain = Read only

Bold = Configurable

Bold underline = Method

Bold italic = Table or graph

Probe Details Image

®
T I(B) --TT-.

(A)

I(C)
W

Steam Reference Probe
Type

None
30cm
50cm

Probe Length Calibration

Calibrates the precise length of the probe which is required for single liquid

low DC application.

Steam Reference
Calibration

Calculates the actual length of the saturated steam reference probe.

Config. Blocking Dist

Block. Dist. High
(Read only)

See B inimage

A region near the flange where
measurements are not possible or are
inaccurate.

Block. Dist. Low
(Read only)

See C in image

A region near the probe end where
measurements are not possible or are
inaccurate. This is somewhat dependent on
the DC of the material being measured.

Loop Current in BD

High Saturation,

Low Saturation,

Last Known Good value,
Default

Select behavior of the analog output when
the PV measurement is in the blocking
distance.

High Saturation: Sets loop current to either
20.5 or 20.8 based on Namur Selection.
Low Saturation: Sets loop current to 3.8
mA.

Last Known Good Value: Loop current
follows the last known PV value.

Default: If distance is in High zone, loop
current is set to high saturation current. If
distance is in Low zone set loop current to
3.8 mA.
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Table 5 - Advanced Configuration parameters, cont’d

Key: Plain = Read only

Bold = Configurable

Bold underline = Method Bold italic = Table or graph

Linearization

Linearization

Disabled
Enabled

The linearization table in the transmitter is either Enabled or Disabled. When
enabled the transmitter’'s, measured values are replaced by corresponding
user-specified corrected values from the linearization table.

Before enabling the user must first configure linearization table, then Send it to
the transmitter. The table can be updated either as complete block (dry
calibration) or single entry (wet calibration) measurements are active.

Note: The Level Linearization feature does not affect the values reported for
the Distance to Product and Distance to Interface device variables. If Level
Linearization is enabled, measured level is no longer described solely by the
basic geometry and it is possible that the Product Level will not be equal to
(Sensor Height — Level Offset — Distance to Product). Likewise, for the
measured interface if is applicable based on measured product type.

Config.
Linearization

Points In Use

2-32

Enter number of index points to be used in the dry and wet linearization tables.
The user can enter up to a maximum of 32 points to construct the tables.

Level Points In
Use

2-32

Linearization Table

In this table for dry linearization, the user can enter pairs of Measured Level
and a corresponding Corrected Level.

Press Send to download the table to the transmitter's memory. Table will be
used after Linearization is enabled.

Refresh
Linearization
Table

Updates the table with recent changes made.

Length Unit
(Read only)

m
cm
mm
in

ft

Length unit used in the linearization tables.

Wet Linearization

In this wet Linearization method, enter a linearized level for the corresponding
level. Press Send to download the table to the transmitter’'s memory.

Save Linear. Enter the date of creation for the linearization table.
Date
Linearization Date of saved linearization table.
Records
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Volume

Vol Calc.
Type

e None

e |deal Tank
Shape

e Strapping
Table
Calculation

Choose volume calculation method as Ideal tank shape if tank has ideal shape
such as Sphere or Cylinder. If tank has irregular shape, then user can select
volume calculation type as Strapping Table Calculation and define Level to
Volume relationship in the table.

Note: Select Volume Calculation Type as None if Volume related device
variables (eg. Product Volume) are not required to be measured and
monitored by device.

Volume Offset

Enter volume correction value, if desired.

Config. Strapping Points 2-50
In Use
Volume Points in Use 2-50

Strapping Table

In this dry volume strapping table, for each point enter a Level and a
corresponding Volume.
Press Send to download the table to the transmitter's memory.

Refresh Strapping Table

Updates table with any changes made.

Length Unit
(Read only)

m
cm
mm
in

ft

Volume Unit
(Read only)

L

ft3

in3
gallon
ImpGal
bbl liquid
yd3

m3

Wet Volume Calibration

In this wet volume strapping table, enter a volume for the corresponding level
for each point. Press Send to download the table to the transmitter’'s memory.

Save Strap. Date

Enter the date of creation/modification of the strapping table.

Strapping Records

Read Only, Date as configured using “Save Strap Date”.
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Correlation Algorithm

Config. Corr. Algorithm

The correlation algorithm searches the full echo curve looking for reflection
shapes that match (that is, correlate highly with) models for reference, surface,
and interface. Each reflection model is a waveform whose shape is defined by
parameters such as gain, width, and amplitude. Under normal circumstances,
the transmitter will automatically find the level of the surface and interface (if
applicable) using the configuration that was shipped from the factory.

If the observed echo curve not correctly indicating reference, surface or

interface then try the following.

1. Step through the basic configuration and make sure that all entries are
correct.

2. Review the Probe Parameters under Advanced Configuration and make
sure that all entries are correct. (Accurate basic and advanced
configuration settings help ensure accurately defined reflection models.)

3. Capture an echo curve.

4. If needed, adjust the radar pulse reflection model parameters for the
Reference, Surface, and Interface (if applicable) to match the radar pulse
reflections in the echo curve.

Reference Reflection

If the transmitter is not finding the Reference point, then adjust the Reference
parameters to match what is seen on the observed echo at the Reference
point location. For example, suppose by zooming in on the observed echo
curve at the Reference point position user can see the observed Reference
Pulse greatest amplitude is -13000 and its width is 180 mm at the x axis;
whereas the configured Reference Gain is -15000 and configured Reference
Width is 200 mm. This means user needs to change the configured Gain to -
13000 and configured Width to 180 mm to match the observed curve.

Refer. Refle. Width

Determines the width of the Reference Pulse where it crosses the x axis (one
half wavelength).

Refer. Refle. Gain

Amplitude (height) of the Reference Pulse wave shape.

Refer. Refle. Attenuation

The attenuation parameter governs how fast the sine wave dies off. Increased
attenuation results in smaller side lobes.

Refer. Refle. Threshold

If changing the gain does not help, try increasing threshold. This value is
related to whether the model pulse match is accepted. Typically, values are
0.5 to 0.6. Increasing it allows poorer matches of the model to the echo.

Prod/Surface Reflection

If the transmitter is not detecting the Product/Surface level, then adjust the
Product/Surface reflection model parameters to match what is seen on the
observed echo at the Surface point location. For example, suppose by
zooming in on the observed echo curve at the Surface point position the
observed Surface wave’s greatest amplitude is 9000 and its observed greatest
width is 150 mm at the x axis; whereas the configured Surface Gain is 7500
and configured Surface Width is 140mm. This means user needs to change
the configured Gain to 9000 and configured Width to 150 mm to match the
observed curve.

Prod. Refle. Width

Determines the width of the Surface wave where it crosses the x axis (one half
wavelength).

Prod. Refle. Gain

Amplitude of the Product/Surface Peak wave shape.

Prod. Refle. Attenuation

Increased attenuation results in smaller side lobes of the wave’s shape.
Increased attenuation results in smaller side lobes of the wave’s shape.

Prod. Refle. Threshold

If changing the gain does not help, try increasing threshold. This value is
related to whether the model pulse match is accepted. Typically, values are
0.5 to 0.6. Increasing it allows poorer matches of the model to the echo.
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Correlation Algorithm, cont’d

Interface Reflection

If the transmitter is not detecting the Interface Level then adjust the Interface
Reflection parameters to match what is seen on the observed echo curve at
the Interface peak reflection. For example, suppose by zooming in on the
observed echo curve at the Interface peak reflection position, user sees the
observed Interface wave’s greatest amplitude is 1200 and its observed
greatest width is 150 mm at the x axis; whereas the configured Interface Gain
is 1000 and configured Interface Width is 140 mm. Then user needs to change
the configured Gain to 1000 and configured Width to 140 mm to match the
observed curve.

Intef Refle. Width

Determines the width of the Interface wave where it crosses the x axis (one
half wavelength).

Intef. Refle. Gain

Amplitude of the peak corresponding to Interface wave shape.

Intef Refle. Attenuation

Increased attenuation results in smaller side lobes of the wave’s shape.

Intef. Refle. Threshold

If changing the gain does not help, try increasing threshold. This value is
related to whether the model pulse match is accepted. Typically, values are
0.5 to 0.6. Increasing it allows poorer matches of the model to the echo.

Probe End Reflection

If the Probe End point is not being found, then adjust the Probe End Reflection
parameters to match the observed echo at the Probe End point location. For
example, suppose by zooming in on the observed echo curve at the Probe
End point position the user can see the observed Probe End wave’s greatest
amplitude is 2000 and its observed greatest width is 90 mm at the x axis;
whereas the configured Probe End Gain is 1500 and configured Probe End
Width is 70mm. This means the user needs to change the configured Gain to
2000 and configured Width to 70 mm to match the observed curve. Note that
the transmitter will only attempt to find the Probe End Reflection if the surface
level is close or below the end of probe.

Prb End Refle. Width

Determines the width of the Probe End wave where it crosses the x axis (one
half wavelength).

Prb End Refle. Gain

Amplitude of the wave shape.

Prb End Refle. Attenuation

Increased attenuation results in smaller side lobes of the wave’s shape.

Prb End Threshold

If changing the gain does not help, try increasing threshold.

Process Connector
Reflection

Process
Rook Remote Mount Cable Connector

P i

Probe Attachment Point

NI
\ IEE

77—
F

I

\ 1/ V VY

Reference PC Start Probe Start

Prcs Connector Refle.
Width

Determines the width of the Process Connector where it crosses the x axis
(one half wavelength).
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Prcs Connector Refle. Gain | Amplitude of the wave shape.

Correlation Algorithm, cont’d

Prcs Connector Refle.
Attenuation

Increased attenuation results in smaller side lobes of the wave’s shape.

Prcs Connector Threshold

If changing the gain does not help, try increasing threshold.

Steam Refrerence
Reflection

If the transmitter is not detecting the steam reference Level, then adjust the
steam reference Reflection parameters to match what is seen on the observed
echo curve at the steam reference peak reflection. For example, suppose by
zooming in on the observed echo curve at the steam reference peak reflection
position, user sees the observed steam reference wave’s greatest amplitude is
1200 and its observed greatest width is 150 mm at the x axis; whereas the
configured Interface Gain is 1000 and configured Interface Width is 140mm.
Then user needs to change the configured Gain to 1000 and configured Width
to 140 mm to match the observed curve.

Steam Ref. Refle. Width

Determines the width of the steam reference wave where it crosses the x axis
(one half wavelength).

Steam Ref. Refle. Gain

Amplitude of the peak corresponding to steam refrence wave shape.

Steam Ref. Refle.
Attenuation

Increased attenuation results in smaller side lobes of the wave’s shape.

Steam Ref. Refle.
Threshold

If changing the gain does not help, try increasing threshold.

Amplitude Tracking

This feature enhances the sensor to track levels under dynamic conditions or
when the radar pulse attenuations in the media are not well known. Once the
sensor has locked onto a correct level, it will track the amplitude of the
reflection rather than using the user configured model amplitude

Config. Calib. Offset

Calibration Offset

Offset to compensate for a change in geometry at the process connector that
affects the measurement.

Reference Plane offset

Read only. Distance between the reference radar pulse reflection and the
physical reference plane (flange) in the factory.

Proces. Connec. Offset

Read only.

Steam reference offset

Read only. Distance between process connector reflection and steam
reference reflection under nominal condition.

Config. Attenuation

Vapor Attenuation

This sets the linear attenuation coefficient (Radar Pulse energy dissipation) of
Vapor.

Upper Prod. Attenuation

This sets the linear attenuation coefficient (Radar Pulse energy dissipation) of
Upper Product (For Two Liquids, otherwise this is just Product/Surface
attenuation).

Lower Prod. Attenuation

This sets the linear attenuation coefficient (Radar Pulse energy dissipation) of
Lower Product. (For Two Liquids, only).
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Services
Install Date (One time editable) Transmitter installation date in MM/DD/YYYY format.
Note: If install date is not configured default date is shown as 01/01/1972.
NAMUR Enabled, Enable or disable the NAMUR output.
Output Disabled Enable: High Saturation current is set to 20.5.
Disable: High Saturation current is set to 20.8.
NAMR Level
Image 4-20 mA dec Output & Failsafe Option 4-20 mA de Output & Failsafe Option
Selections Selections
Mamur _of Haneywell Mamur ar Honeywell
21.0 mA O _HBO 4 590ma 29.0ma 4 _HBO  HBOD 4 o0 0
P 20.8 mA . 508 mA
20.5 mA Narma Normal 0.5 mA *Normm Jorma 0.8 mA
100% = 20 mA 100% = 20 mA
HBO - High Burnout HBQ - High Burnout
LBO - Low Burnout LBO - Low Burnout
0% == 4 ma 0% =4 4 ma
3.5 ma glermal Normaly 3.5 mpa 3.8 ma ghormal [Hermaly 5 g
FEMAE 5y go ¥ 3EMA 3EMAFTEE Lo aAmA
NAMUR Disabled NAMUR Enabled
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Services cont.

Write Protection
Image

Read / Writg

OFF ON

Write Protect Jumper Rc_ead Only

OFF ON
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Write protect

Displays the current configuration of the write protect function. Write Protect is “Enabled” if
either the write protect jumper on the electronics board is in the “ON” position or the
firmware write protect has been enabled.

The write protect jumper must be set in the Enabled position for SIL safety applications.

Write Protect

On/Off

Configure the firmware write protect option.

Write Protect selections are:

Enable: Enables the firmware write protect option (changes in configuration parameters
will not be permitted).

Disable: Disables the firmware write protect option (requires a password).

A 4-digit password is required to change the Write Protect option from “Enabled” to
“Disabled” to allow configuration changes. The default password is “0000”, and can be re-
configured by the user.

Note: This cannot be changed if transmitter's Write Protect hardware jumper is disabled.
See the SLG700 Transmitter User’s Manual, Document #34-SL-25-11 for details.

Change
Password

Used to change the write protect password. Disable write protect option before changing
the password.

Disable: Disables the firmware write protect option (requires a password).

A 4-digit password is required to change the Write Protect option from “Enabled” to
“Disabled” to allow configuration changes. The default password is “0000”, and can be re-
configured by the user.

Enter old password and then enter New password.

Apply values

Applied re-range. Set 4 mA and 20 mA by current applied process values

D/A trim

Defined in section 4.3.1

Loop test

Used to perform the loop test.
Choose 4 mA and 20 mA analog output levels and fix the field device outputs at 4 mA and
20 mA
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Services cont.

Config.
Tamper Alarm

The Tamper Alarm feature provides a warning if more than a specified
number of attempts or actual configuration changes are made, whether
write protected or not, when Tamper Alarm is Enabled. The warning
stays active until the specified latency period has elapsed after the
Primary Master reads the corresponding status byte. Examples of
attempted configuration changes: moving the Write-Protect jumper,
entering a wrong password.

The method allows user to configure the following parameters in the
order as specified below:

1. Tamper Mode

2. Tamper Latency

3. Maximum Allowable Attempts

Tamper Mode

When enabled, the “Attempt Counter” will keep track of the number of
times an attempt is made. After the configured “Max Attempts”, an
alarm status (non-critical flag) is generated.

Attempt Displays the number of device configuration change attempts made
Counter when tamper mode is enabled.
Changing the tamper mode from enable to disable and vice-versa is
also considered as configuration change attempt and “Attempt
Counter* is incremented.
If user configures “Max Allowable Attempts” to a value less than the
current “Attempt Counter “ then “Attempt Counter “ is clamped to “Max
Allowable Attempts.
Tamper 0-60 seconds. Tamper latency is the time period for which the tamper
Latency alarm remains set in response of command 48 and reflected as

“Tamper Alarm” Device Status condition.

Max Allowable

Maximum number of tamper attempts to be permitted before the

Attempts Tamper Alarm is generated.
Reset Tamper Reset the Attempt Counter to zero.
Counter

Master Reset

Selecting this option will cause a Master Reset of the transmitter, which
is the equivalent to power cycling the device.

Lock/Unlock
Device

Select the Lock state for access by HART configuration tools.

If “Yes” is selected to lock the device, also select “Yes” or “No” to
choose whether the lock is “permanent.” If the lock is not permanent, it
will be cleared on power cycle or Master Reset of the device.

If “Yes” is selected to unlock the device, the lock state will be cleared.

Factory Reset

Resets all device configuration parameters to their factory defaults and
triggers a soft reset. The User will be prompted to confirm they want to
take this action.

Reconcile
Model
Numbers

Read and display both Comm and Sensor Model Numbers.
Display Model Number Mismatch non-critical diagnostic.

Provide a Match Model Number command with selections to match
from Comm or match from Sensor, which is only visible or enabled
during a Model Number Mismatch diagnostic.

Reset NVRAM

Displays the status of NVRAM in Communication module and Sensor

Corruption Module.
In case of NVRAM corruption you can select to reset the individual
error, condition and revert to the default parameters. Warning, this can
lead to incorrect measurements and should be used with caution
Licensed Displays the currently enable Licensed Options and allows the entry of
Option a license key to enable newly purchased options.
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Local Display
Display Yes: Display is connected
Connected No: Display is not connected
Type of Type of local display installed on the transmitter.
Display
Common
Setup
Change Select password that will be required for access to the display.
Password
Language User configurable languages supported by transmitter are English,

French, German, Spanish, Russian, Turkish and Italian.

Rotation Time

Length of time each configured screen is visible before rotating to the next
available screen, when screen rotation time is selected as “Yes”. Available
range of screen rotation time is from 3 to 30 seconds.

Screen Screen rotation configuration can be either Yes or No. When user selects

Rotation Screen Rotation as Yes, all the screens configured will rotate with set
Rotation Time.

Contrast Display contrast level selection range from 1 (low) to 9 (high).

Level

Screen Info

Read Display Method used to read selected screen configuration details.

Screen

Configure Method used to configure specific screen.

Display

Screen

Screen Provides details of last configured screen using method “Configure

Number Display Screen”.
Possible Screen numbers are 1-8.

Custom Tag Custom tag name for the screen title up to 14 alphanumeric characters

Disp High Upper limit shown on the Bar Graph or Trend screen

Limit

Disp Low Limit Lower limit shown on the Bar Graph or Trend screen.

Screen Format

Provides details of last configured screen using method “Configure
Display Screen”.
Possible Screen formats are:

PV only

PV & bar graph

PV & trend
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Screen Info

PV Selection

Product Level

Product Level %
Distance To Product
Product Level Rate
Vapor Thickness
Vapor Thickness %
Interface Level
Interface Level %
Distance To Interface
Interface Level Rate
Upper Product Thickness
Product Volume

Vapor Volume

Lower Product Volume
Upper Product Volume
Loop Output Percent
(Output mA)

Select Process Variable (PV) to be displayed. Choices
depend on product being measured.

Display Units

Distance:

ft, in, m, cm, mm
Volume:

ft3, in3, US gal, Imp gal,
barrels, yd3, m3, liters
Level Rate:

ft/s, m/s, in/min, m/h
Internal temp:

F,C

Select display’s units.

Decimals

Display’s decimal point position.

Trend Duration

For “PV and trend” display option, enter a trend duration time
from 1 to 999 hours.

Summary

Summary

Shows the important advanced configuration parameters.

Page 34

SLG700 Series HART Option User’'s Manual Revision 6




Table 6 - Monitor parameters

Key: Plain = Read only

Bold = Configurable

Bold underline = Method

Bold italic = Table or graph

Dashboard

PV Is
PV
SV s
sV
TV s
TV
QVls
Qv

Product Level
Product Level %
Distance To Product
Product Level Rate
Vapor Thickness
Vapor Thickness %
Interface Level
Interface Level %
Distance To Interface
Interface Level Rate
Upper Product
Thickness

Product Volume
Vapor Volume

Lower Product Volume

Upper Product Volume

Displays measured values for dynamic variables PV,
SV, TV and QV, as configured from the choices at
left.

PV Loop current

Live value of PV output current.

Internal Elect. Temp.

Live value of sensing module electronics
temperature.

Interface Sig. Strength

Lower Product signal strength.

Interface Sig. Quality

Lower Product signal quality.

Surface Sig. Strength

Upper Product signal strength.

Surface Sig. Quality

Upper Product signal quality.

Refresh Signal Info

This will get the live values of signal Strength and
Quality.

Meas. Product Level

Non linearized value of product level.

Distance To Product

Live value of distance to product.

Distance To Interface

Live value of distance to interface.

Meas. Interface level

Non linearized value of Interface level.
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Dashboard, cont’d

Process monitoring

PV

Trend of PV

PV

PV Meter

SV

Trend of SV

SV

SV Meter

TV

Trend of TV

TV

TV Meter

Qv

Trend of QV

Qv

QV Meter

Live values of dynamic variables in trend or meter form.

ET

Live value of sensing module internal electronics

Trend of ET

temperature.

ET

ET Meter

PV AO

Live value of PV analog output.

Trend of AO

PV loop current

Live value of loop current.

AO Meter

Live value of AO

PV AO Percent

Live AO %

PV % rnge

Live PV %

PV % rnge

Live PV %
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Device Status

Critical Displays all possible Critical Status faults and indicates
OFF for inactive faults or ON for active faults.

Help- Critical Provides a more detailed description of each Critical

Diagnostics Status fault.

Non-Critical Displays the first set of possible Non-Critical Status faults
and indicates OFF for inactive faults or ON for active
faults.

Help- Non Crit. Provides a more detailed description of each of the first set

Diagnostics of Non-Critical Status faults.

Non-Critical Displays the second set of possible Non-Critical Status
faults and indicates OFF for inactive faults or ON for active
faults.

Help- Non Crit. Provides a more detailed description of each of the second

Diagnostics set of Non-Critical Status faults.

Non-Critical Displays the third set of possible Non-Critical Status faults
and indicates OFF for inactive faults or ON for active
faults.

Help- Non Crit. Provides a more detailed description of each of the third

Diagnostics set of Non-Critical Status faults.

Non-Critical Displays the fourth set of possible Non-Critical Status
faults and indicates OFF for inactive faults or ON for active
faults.

Help- Non Crit. Provides a more detailed description of each of the fourth

Diagnostics set of Non-Critical Status faults.

Extd dev status

Displays all possible Extended Device Status faults and
indicates OFF for inactive faults or ON for active faults.

Help- Extended Device
Status

Provides a more detailed description of each Extended
Device Status fault.

Additional status

DAC Failure

Communication

Display & Sensor

Other Info

Sensor

Sensor

Database integrity

Database integrity

RAM Integrity

RAM Integrity

Display Integrity

Displays additional status of these components.

Reset Database

Provides recovering from NVRAM corruption. When this is
activated sensor/COMM will reset NVRAM corrupted alarm
and default the database. Resetting of COMM/Sensor
NVRAM alarms should be done separately - specific user
interface and separate bits in HART command that specify
which alarm should be reset. When resetting COMM alarm,
a warning "transmitter configuration will be defaulted”
should be displayed. For sensor alarm reset, warning
should be "calibration and characterization data will be
defaulted".
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Device Information

Manufacturer Manufacturer ID

Model Model ID

Dev id Device ID

Universal rev HART universal revision

FId dev rev Device revision

Software rev Device software revision

Sensor SW Rev Sensor module software revision number
Dev SW Rev

Database SW Rev

Display SW Rev Display module software revision number
Install Date Installation date

Cfg chng count Number of times any configuration

parameter was changed.

Final asmbly num

Num req preams Number of request preambles.
Poll addr Polling address of device
Service Life Percent of expected Service Life that device

has been in service. Value is based on
electronics temperature. Service life
accumulates faster at higher temperatures
with an exponential relationship.

Stress Life Percent of service life spent in stressful
conditions. Indicates the % of service life
where electronics temperature is within 10%
of respective range limit % of Service life
spent either in 10% of lower limit range or
10% of upper limit range. Refer to Table 11.

Power Cycles Number of power cycles.
System Connections Typical system connection image
Model Number Provides details of device Model key and

Model Number information.
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Echo Curve

Config. Echo Curve Configures how to generate echo curve from
transmitter.

Echo Curve Type Windowed Echo Curve Windowed Echo Curve: Used by algorithm
to find level measurements. Surface and
Interface windows are tracking surface level
and interface level respectively. Background
subtraction near the reference plane is
applied when needed. Useful for
troubleshooting correlation algorithm.

Full Echo Curve Full Echo Curve: The full “raw” echo curve,
i.e. not windowed and no background
removal or other processing done to it.
Useful for troubleshooting process.

Processed (Full) Echo Processed (Full) Echo Curve: Echo curve
Curve with background removal. Useful for
troubleshooting process or correlation
algorithm.

Background Subtraction

Background Subtraction Array: This array
Array

contains the echo curve in the reference
plane region when the surface level is far
away from the reference plane. This array
can then be subtracted from the echo curve
to improve near zone performance.

Echo Distance Unit Ft Units of distance on curve.

cm
mm

Echo Curve Start Distance Distance from reference to begin the curve.

Echo Curve End Distance Distance from reference to end the curve.

Echo Curve Resolution Distance between samples on the curve.
Lower number results in more detail but
takes longer to process.

Echo Resolution Unit Units for Echo Curve resolution
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Observed Dist. Echo Curve Displays the echo curve observed. Key
points are marked by dots. Example below.

11| Observed Echo Curve - echo | ® X

»runlflaaa
8000.0+
6000.0+
4000.0
2000.0

0.0+
-2000.0

T T T T
0.0 100.0 200.0 300.0
cm

Options Return

Zoom in on a point to increase detail.

11| Observed Echo Curve - echo | ® X

» nflaaa
3000.0-
2000.0-
1000.0+
0.0+
-1000.0
-2000.04

T T T
100.0 150.0 200.0 250.0
cm

Zoom again in on a point to increase detail.

11| Observed Echo Curve - echo | ® X

»nBlaaa

-800.0-
-1000.0
-1200.0
-1400.0
-1600.0
-1800.0 _

-2000.0+

T T T T
1500 1600 1700 180.0

cm
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Echo Curve Type

Windowed Echo Curve

Full Echo Curve

Processed (Full )Echo Curve
Background Subtraction Array

Start Distance

Distance from reference to begin the curve.

End Distance

Distance from reference to end the curve.

Echo Distance Unit

Echo Resolution Units

Ft

cm
mm

Distance units used on curve.

Echo Resolution

Distance between samples on the curve.
Lower number results in more detail but
takes longer to process.

Echo Curve Stem Plot Data

Reference Amplitude

Observed reference amplitude

Process Conn. Refl. Amplitude

Observed reference amplitude

Prod/Surface Amplitude

Observed Surface amplitude

Product/Surface At

True Surface distance

Interface Amplitude

Observed Interface amplitude

Interface Refl. At

True Interface distance

Probe End Amplitude

Observed Probe End amplitude

Probe End Refl. At (True)

True Probe End distance
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Adv Diagnostics

PV Tracking See Table 9 - PV Tracking Diagnostics
PV Low Value page 54.
PV High Value

Low Alarm Limit

Low Alarm Counter

High Alarm Limit

High Alarm Counter

Change Alarm Limits

Reset PV Tracking

SV Tracking See Table 10 - SV Tracking Diagnostics
SV High Value page 55.
SV Low Value

Low Alarm Limit

High Alarm Limit

Low Alarm Counter

High Alarm Counter

Change Alarm Limits

Reset SV Tracking

ET Tracking See Table 11 - ET Diagnostics page 56.

ET

Max ET Limit

Max ET Value

Last ET Up Details

ET USL

Time Above USL

Min ET Limit

Min ET Value

Last ET Down Details

ETLSL
Time Below LSL
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Adv Diagnostics, cont’d

Operating Voltage

Loop Voltage

Min Loop Voltage

MSP 430 VCC

Voltage Tracking

Reset Volt. Tracking

MCU Supply Voltage

Power Cycles

Last Power Cycle

See
Table 12 - Operating Voltage Diagnostics

Config History

First History Parameter

Second History Parameter

Third History Parameter

Fourth History Parameter

Fifth History Parameter

Exit

Displays a history of the last five
configuration parameters that have been
changed. See Table 13 - Configuration
Change History Diagnostics

Error Log

Error Log Flag

Show Error Log

Reset Error Log

Enable and disable error logging.

If error log is enabled all critical errors
triggered will be logged with a time stamp
(elapsed time since power up). See Table 14
- Error Log Diagnostics

Table 7 - Tamper Reporting Logic Implementation with Write Protect

Write Protect Write Protect Configuration Tamper Tamper Alerted
Jumper Status Software Change Reporting Status Posted?
P Status Allowed?
ON ON or OFF NO
OFF ON NO
(or missing)
OFF OFF YES
(or missing)
ON YES
OFF NO
Note: Tamper Reporting is independent of Write Protect status.
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The following sections give some examples as to how to edit the configuration parameters and
execute Methods.

3.2.10 Procedure to Enter the Transmitter Tag
1. From the My Device menu, make the following menu selections:
Shortcuts > Device Setup > Basic Configuration > General > Tag.
Click Edit. The Tag screen will be displayed.
Key in the tag name (for example: SLG700) which can be a maximum of eight characters.
Click OK. The Send to Device screen will be displayed.
Select the Tag check box.

Click Send to download the change to the Transmitter, or Click Return to continue making
changes.

No ok~

3.2.11 Saving device history

FDC provides the user with a feature wherein they can save the device configuration snapshot as
history. This history record may then be transferred to a central asset management database such
as FDM.

Using this feature the user can save the device configuration snapshot as device history of a
connected device at any given time in a predefined location. The following are the features of save
device history option.

e Two formats of history are supported: FDM and DocuMint.

¢ Only one snapshot per device instance is allowed to be saved and can save the
snapshot of a device any number of times overwriting the existing one.

To save device history, perform the following steps.

1. On Device Home page, tap Tools.
2. Select Save History and tap Select
The Save History page appears.
& save History

History Record Name:

|NewDeviceReu:u:urd | |_‘ JI

Device Tag:

|DevTag | ¥ J'

Faormat:

() FOM

() Docurmint

1. Enter the History Record Name using the keypad and tap OK. History Name field
accepts alphanumeric characters, underscore, and no other special characters.
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2. Enter the Device Tag using the keypad and tap OK. Device Tag field accepts
alphanumeric characters, underscore, and no other special characters.

The device can be identified with History Record Name and Device
Note: Tag in FDM, once the record is imported in FDM, provided the device
is not already present in the FDM network.

3. Select the Format. The following are the available formats:
4. FDM

5. DocuMint

6. Tap Save to save device history record.

7

If a history record for this device already exists, the following warning message
appears.

@ Crvarwtita pravious files for
this device?

Yes Mo

8. Tap Yes to overwrite the existing name. A overwrite success message appears.
9. Tap OK to return to Device Home page.

3.2.12 Exporting device history records to FDM

The history snapshot saved in FDC can be imported into FDM for record and audit purposes. This
is enabled by the standard Import/Export wizard in FDM. This way FDM allows synchronizing the
device configuration data through the MC Toolkit handheld.

Bwnp =

10.

To export device history from FDC and import it in FDM, perform the following steps.
Connect the MC Toolkit handheld to the computer as described earlier.
Browse to the folder on the computer, SD Card > FDC > Resources > History.

The FDC history records are named as per the following convention for the primary name:
DeviceTag_ManufacturerIDDeviceTypeDeviceRevisionDDRevision_DevicelD

Copy the desired Device History Record files (with .fdm extension) from the above mentioned
location to a temporary location on FDM Client computer.

Use FDM Import/Export wizard to import the history records into FDM. After imported
successfully:

The snapshot would get imported into FDM database and appear as a history record for the
corresponding device in FDM.

The Audit Trail entry for such a record identifies it as being imported through the MC Toolkit
handheld.

If the device is not part of any of the FDM configured networks, it would appear under
‘Disconnected Devices’ in FDM network view.

All operations allowed on Device History Record in FDM will be allowed for the record
imported through the MC Toolkit handheld.

For more details on using FDM Import/Export feature, refer to section

Note: Importing and Exporting Device History in FDM User’s Guide.
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3.2.13 Exporting device history records to Documint
To export device history from FDC and import it in FDM, perform the following steps.

1. Connect the MC Toolkit handheld to the computer as described earlier.
2. Browse to the folder on the computer, SD Card > FDC > Resources > History.

3. The FDC history records are named as per the following convention for the primary name:
DeviceTag_ManufacturerlIDDeviceTypeDeviceRevisionDDRevision_DevicelD

4. Copy the desired Device History Record files (with .xml extension) from the above
mentioned location to a temporary location on the DocuMint system.

5. For Importing in DocuMint: Select Procedures > Import or the Import option in the tool bar.

For more details on using DocuMint Import feature, refer to section

Note: Importing from XML File in Document Help.

3.2.14 Custom Views

FDC provides the user a unique feature wherein the user can choose what they want to view in a
device and thus creating your own custom views. This is a very convenient utility when the user is
interested in select few variables in a device and saves time for navigating through the menus.

The user can create two views per device type with maximum of 10 variables selected for each
custom view.

To create/modify the custom views, perform the following.

1. On Device Home page, tap My Views.
2. Tap Configure and tap Select.
The Configure My Views dialog box appears.
To customize View1l and View?2, select the variables by checking the box against desired
variables.
3. Tap ¥ or = to navigate to previous and next set of variables.
4. Once done, tap Options to select Save My Views.
Two custom views are ready with selected variables.

Since a custom view can contain only up to 10 variables each, a

Note: warning is displayed if more than 10 variables have been selected

To rename the views, perform the following.
5. Tap Options > Rename Viewl.

A dialog box appears informing the user to enter the name.
6. Tap Ok.
7. Tap Option>Save to persist the change

8. Tap Return to return to My Views page. There are two options with the names
assigned to the newly created views.
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Note: To view the custom views, tap My View 1 > Select.

The My View 1 page appears.

Label Value Unit
& Dev id 8980224
Wy Dev SW Rev 1.010000
o Display SW Rev  1.010000
& Fld dev rev 2

O Install Date 03/12/2...
W Long tag

& Manufacturer Honeywell
W Message
& Model SLG700

@ Poll addr 0
¥ Send

Edit the parameters that are Read / Write and select Send.

For more details on any of the FDC features, refer to the MC Toolkit User Manual, Document

# 34-ST-25-50.
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3.2.15 Offline Configuration

Overview

Offline Configuration refers to configuring a device when the device is not physically present or
communicating with the application. This process enables the user to create and save a
configuration for a device, even when the device is not there physically. Later when the device
becomes available with live communication, the same configuration can be downloaded to the
device. This feature enables the user to save on device commissioning time and even helps the
user to replicate the configuration in multiplicity of devices with lesser efforts. Currently, FDC does
not support creating offline configuration. However, it supports importing of offline configuration
from FDM R310 or later versions. The configurations thus imported can be downloaded to the
device from FDC.

The following are the tasks that the user needs to perform for importing offline configuration in
FDC application software and then downloading it to the device.

e Create offline configuration template in FDM

e Save the configuration in FDM in FDM format.
o Import the offline configuration in FDC

e Download the offline configuration to the device

For details on creating and using offline configuration, refer to section

Note: Offline configuration in FDM User’s Guide.

Importing offline configuration

Using this feature the user can import offline configuration template. The offline configuration
template has to be created in FDM and saved in FDM format. Copy the .fdm files into the storage
location of the FDC.

To import an offline configuration, perform the following steps.

1. Onthe FDC homepage, tap Offline Configuration > Select.
The Offline Configurations page appears.
2. Tap Options > Import.
The Select a File dialog box appears.
3. Navigate to the location where the offline configuration template is stored.
4. Select the required offline configuration template from the list.
5. Double-tap and the offline configuration template is imported.
A success message appears.

In case if the offline configuration template is already imported, an

Note: .
overwrite message appears.

6. Tap OK to return to the Offline Configurations page. The device details appear on the
bottom of the page.
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Deleting offline configuration

Using this feature the user can delete an offline configuration template.

To delete an offline configuration, perform the following steps.

On the FDC homepage, tap Offline Configuration > Select.
The Offline Configurations page appears.

Select the required offline configuration template from the list.
Tap Options > Delete. A warning message appears.

o~ w b

Tap Yes to delete the offline configuration template.

Downloading an offline configuration
Using this feature, the user can download the offline configuration when the device is online.

To download an offline configuration, perform the following steps.
1. Onthe FDC homepage, tap Offline Configuration > Select.
The Offline Configurations page appears.
2. Select the required offline configuration template from the list.
3. Tap Options > Download.
The Offline — Select Variables page appears with the all the variables.

By default, all the variables selected in FDM will appear as selected

Note: and non-editable variables appear in grey color.

1. Select the required variable. In case the user selects a dependent variable, then
variables on which it is dependent on will also be selected and the following warning
appears.

- Offline - Information

To write this variable, the following
atiables will also be selected:

1, STATUS ACCESS

, SYSTEM OPTION BCC

I3, SYSTEM OPTION ADY, DLAG,

2. Tap OK to return to the offline wizard.
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3. Tap Next.

The Offline — Review and Send page appears with the list of selected variables.

1. Tap Send and the process to send the variables to the device starts. Once the
downloading is complete, the following page appears.

i Offline - Status

Label Value

Measured Products Single Li... FAILED |z
Length Unit m FAILED
Volume Unit m3 SUCC... |&
Type Of Display ... west FAILED
PV Unit m SUCC...
PV is Product ... SUCC...
PV URV 1 SUCC...
Block. Dist. High 0 FAILED
Block. Dist. Lowy 0 SUCC...
Language English SUCC...
Probe Length 1.2 FAILED
Calibration Offset 0.2 FAILED
Level Offset 0.3 FAILED
Volume Offset 0 SUCC...
Max. Product Level 1.2 SUCC...

If the variables are downloaded successfully, status appears as
Note: SUCCESS in green color; and if failed, status appears as FAILED in
red color.

2. Tap Finish to return to FDC Homepage.
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4 Analog Output Calibration

4.1 About This Section

This section provides information about how to calibrate a transmitter’'s analog output circuit.

ﬂ All procedures in this manual assume the Transmitter is configured for Loop Current
Mode enabled, see section 4.3.2.

4.2 Equipment Required

e Digital Voltmeter or milli-meter with 0.02 % accuracy or better
e 250 ohm resistor with 0.01 % tolerance or better

4.3 Analog Output Signal Calibration Trim

With a Transmitter in its constant current source mode, its analog output circuit can be trimmed at
its 0 (zero) % and 100 % levels. It is not necessary to remove the Transmitter from service.

The user can calculate milliamperes of current from a voltage measurement as follows:

Dc milliamps = 1000 X voltage/resistance

" IMPORTANT: Be sure that the accuracy of the resistor is 0.01% or better for current
measurements made by voltage drop.

4.3.1 Procedure with handheld communicator
1. Connect the MC Toolkit across loop wiring, and turn it on. See Figure 2 page 4 for a

sample test equipment hookup.
2. Launch the FDC application.

3. Onthe Home page, select Online and establish a connection with the device as

follows;
4. Select the My Device menu, and choose from the following menus:
a. Online>Device setup>Advanced Configuration>Services>D/A Trim
b. My Device> Device setup>Advanced Configuration>Services>D/A Trim

5. The user will be prompted to remove the loop from automatic control; after removing

the loop from automatic control, press OK.

6. When a prompt appears connect reference meter in the loop to check readings, and

press OK. The following prompts will be displayed:
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a. Setting fld dev to output to 4mA. Press OK
b. Enter meter value. Key in the meter value, and press ENTER.
c. Fld dev output 4.000 mA equal to reference meter?

1 Yes
2 No

o If the reference meter is not equal to the field device output then select No
and press Enter

o Key in the new meter value

Return back to the "Enter Meter Value” prompt until the field device output
equals the reference meter

o Select Yes and press Enter
7. The following display prompts will appear:

e Setting fld device output to 20mA. Press OK
e Enter meter value. Key in the meter value, and press ENTER.
e Field device output 20.000 mA equal to reference meter?
1Yes
2 No

o Ifthe reference meter is not equal to the field device output then select No
and press Enter

Key in the new meter value

Return back to the "Enter Meter Value” prompt until the field device output
equals the reference meter

o Select Yes and press Enter
8. The prompt notifies the user that the field device will be returned to its original output
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4.3.2 Procedure with DTM
1. Go to Advanced Configuration>Services>DAC Calibration

2. Press the Begin button. (This will automatically put transmitter into Fixed Current
Mode at 4mA)

3. Enter the value read at multi-meter into field under “Enter Zero Trim Value (4mA)
read at multi-meter”

4. Press the Set button under Enter Zero Trim Value (4 mA) read at multi-meter. This
will automatically put transmitter into Fixed Current Mode at 20 mA.

5. Enter the value read at multi-meter into field under.
6. Press the Set button under Enter Span Trim Value (20mA) read at multi-meter. This

will automatically put transmitter into Loop Current Mode (where current follows
PV value).
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5 Advanced Diagnostics

5.1 About This Section

This section provides information about the Advanced Diagnostic features in the SLG700

SmartLine Level Transmitter.

5.2 Advanced Diagnostics

Table 8 - Viewing Advanced Diagnostics

What you want to view

What to do

PV (Primary Variable) Tracking

SV (Secondary Variable )Tracking

ET (Electronics Temperature) Tracking
Operating Voltage Tracking
Configuration History

Select Start>FDC to Launch the FDC
application on the MC Toolkit.

On the Home page, select Online and
establish connection with the device.

Select My Device>Monitor>Adv Diagnostics.

Error Log

Table 9 - PV Tracking Diagnostics
PV Low Method Description Minimum PV that the device has experienced since power-
Value up, in user selected units.

Set-up None. Value initialized to Min PV Limit value prior to leaving
the factory. Updates to current PV automatically when
powered at user site after valid initial measurement.

PV High Method Description Maximum PV that the device has experienced since power-
Value up, in user selected units.

Set-up None. Value initialized to Min PV Limit value prior to leaving
the factory. Updates to current PV automatically when
powered at user site after valid initial measurement.

Low Alarm Parameter Description PV specified lower operating limit in user-selected units
Limit Set-up None
Low Alarm Parameter Description Number of times PV Low Alarm Limit has occurred.
Counter Set-up None
High Alarm Parameter Description PV specified upper operating limit in user selected units.
Limit Set-up None
High Alarm Parameter Description Number of times PV High Alarm Limit has occurred.
Counter Set-up None
Change Method Description Changes alarm limits.
Alarm Limits Set-up None
Reset PV Parameter Description Resets alarm counters to 0. Sets PV Low and High limit
Tracking values to current measured PV value.

Set-up None
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Table 10 - SV Tracking Diagnostics

SV Low Method Description Minimum SV that the device has experienced in user
Value selected units.

Set-up None. Value initialized to Min SV Limit value prior to leaving
the factory. Updates to current SV automatically when
powered at user site after valid initial measurement.

SV High Method Description Maximum SV that the device has experienced in user
Value selected units.

Set-up None. Value initialized to Min SV Limit value prior to leaving
the factory. Updates to current SV automatically when
powered at user site after valid initial measurement.

Low Alarm | Parameter Description SV specified lower operating limit in user-selected units
Limit Set-up None

Low Parameter Description Number of times SV Low Alarm Limit has occurred.
Alarm Set-up None

Counter

High Alarm | Method Description SV specified upper operating limit in user selected units.
Limit Set-up None.

High Parameter Description Number of times SV High Alarm Limit has occurred.
Alarm Set-up None

Counter

Change Method Description Changes alarm limits.

Alarm Set-up None.

Limits

Reset SV Parameter Description Resets alarm counters to 0. Sets SV Low and High limit
Tracking values to current measured SV value...

Set-up None.
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Table 11 - ET Diagnostics

Max ET Parameter Description Electronics Temperature (ET) upper operating limit from
Limit specification. Value is in user specified temperature units.
Set-up None.
ET Method Description Actual limit used in “Time Above Limit” and “Time Since Last
USL(upper Event”. Value is equal to “Max ET Limit” less 10% of limits
stress limit) range.
Example Electronics Temperature range is -40°F to 185°F for a total of
225°F,
“ET Upper Stress Limit’= 185°F - 10% of 225°F = 162.5°F.
Set-up None — calculation is automatic.
Max ET Parameter Description Highest Electronics Temperature ever experienced by the
Value device. Value is in user specified temperature units,
Set-up None.
NVM Update every 8 hour.
Time Above | Parameter Description Accumulation of minutes that device’s Electronics
USL (Upper Temperature has been above the value of “ET Upper Stress
Stress Limit”.
Limit) Set-up None.
NVM Backup once each 8 hour period
Last ET up Method Description Time that has passed since the last time device’s Electronics
details Temperature has passed above the value of “ET Upper
(Time Since Stress Limit” (in days, hours and minutes).
Last ET Up) Set-up None.
NVM Backup once each 8 hour period
Min ET Parameter Description Electronics Temperature (ET) lower operating limit from
Limit specification. Value is in user specified temperature units.
Set-up None.
ET LSL Method Description Actual limit used in “Time Below Limit” and “Time Since Last
(Lower Limit Event”. Value is equal to “Min ET Limit” plus 10% of limits
for Stress range.
Condition) Example Electronics Temperature range is -40°C to 85°C for a total of
125°C.
“ET Lower Stress Limit” -40°C + 10% of 125°C = -27.5°C.
Set-up None — calculation is automatic.
Min ET Parameter Description Lowest Electronics Temperature ever experienced by the
Value device. Value is in user specified temperature units.
Set-up None.
NVM Update every 8 hour.
Time Below | Parameter Description Accumulation of minutes that device’s Electronics
LSL (Lower Temperature has been below the value of “ET Lower Stress
Stress Limit”.
Limit) Set-up None.
NVM Backup once each 8 hour period
Last ET Method Description Time that has passed since the last time device’s Electronics
Down Temperature has passed below the value of “ET Lower
Details Stress Limit” (in days, hours, and minutes).
(Time Since Set-up None.
LastET NVM Backup once each 8 hour period
Down)
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Table 12 - Operating Voltage Diagnostics

MSP 430 VCC Parameter Description MSP430 VCC in volts
Loop Voltage Parameter Description Operating voltage available at device terminals.
(Current Op Set-up None — units always in volts.
Voltage) NVM none
Note No accuracy is specified for this measurement!
This value is intended to be used for informational
purposes only and should not be used for control.
Min. Loop Parameter Description Minimum operating voltage experienced by device at
Voltage terminals since last reset of operating voltage
(Minimum parameters.
Operating Set-up User can reset as desired using method described in
Voltage) item below.
NVM Backup once each 8 hour period
Voltage Tracking Method Description Displays time since last minimum operating voltage
(Time Since Last event in minutes.
Voltage Low) Set-up User can reset as desired using method described in
item below.
NVM Update every 8 hour.
Reset Vol. Method Description Causes “Min Op Voltage” to be set to 32 volts and
Tracking(Operati “Time Since Last Event” to be reset to zero. Within a
ng Voltage short period of time “Min Op Voltage” will assume
Parameters) operating voltage value.
Set-up User actuates as desired.
MCU Supply Parameter Description Sensor MCU Supply voltage in volts
Voltage
Power Cycles Parameter Description Total number of power-ups experienced by the device.
Set-up None — initialized to zero prior to leaving factory.
NVM The count is stored in NVM.
Time Since Last Method Description Displays time since last power cycle event happened in
Power Cycle minutes.
Set-up None.
NVM The information is stored in NVM at every 8 hours of
continuous device operation.
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Table 13 - Configuration Change History Diagnostics

Config History

Method

Description Provides configuration change history of
device parameters.

Out of the last five configuration change
instances, user can select the specific
instance to view the associated parameter
changed.

Set-up None

NVM Information is stored in NVM whenever
configuration change is successful,
Configuration change details of
Linearization and Strapping details are
not tracked and cannot be retrieved
using configuration change history

Table 14 - Error Log Diagnostics

Error Log

Method

Description Error log time stamp is provided based
on sequence number of error event
Set-up Error log has to be enabled to log details.
NVM The information is stored in NVM at
every 8 hours of continuous device
operation.
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6 Troubleshooting and Maintenance

6.1 Power-Up Behavior

On power-up the loop current is set to 21.5 mA and HART digital communication by default. Start
up time is 45 seconds from when the device is powered up.
Distance to Product and Distance to Interface (if applicable) are set to zero and the loop current to
21.5 mA until a valid level is detected by the transmitter. In case of critical faults the device sets
the loop current to burnout level as programmed (Low scale <3.6 mA or High scale 21.5 mA).

6.2 HART Diagnostic Messages

6.2.1 Critical diagnostics
Table 15 details critical HART diagnostic messages, also called alarms.

Table 15 - HART Critical Diagnostic Messages

Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

Reset required

This flag is set when sensor
parameters configuration is changed
that requires a device reset.

Power cycle the device to perform a
hard reset of all transmitter
electronics. New reflection models
and minimum blocking distance limits
will be calculated while the transmitter
is starting up.

Measurement Failure

This is a roll-up status bit that is set
when any of the following critical status
conditions are present.

If Device variable selected as Primary
Variable (PV) is not applicable for
configured measured product.

o PV selected is any of Volume
device variables and the value is
either infinite or not a valid number.

e PV Selected is derived from
measured level which is either
infinite or not a valid number.

e Primary Variable bad

If the non-critical Device Variable Not
Supported status is set, check if the
device variable selected as Primary
Variable is applicable for the
configured measured product type.
See page 19.

If the non-critical Volume Calculation
Failure status is set, check if Volume
Calculation Type is configured as
“Strapping table”, check the Strapping
table entries for valid data. If Volume
calculation type is selected as “Ideal
Tank Shape” check the tank
dimensions configured are valid and
correct.

If the non-critical Linearization Table
Error Status is set, check the
Linearization table for valid entries
corresponding to Measured and
Adjusted level values.

If the non-critical PV bad is set, check
the distance to interface or distance to
product used to derive the Primary
variable is valid or not. The reason
may be due to loss of surface or
Interface peak.
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Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

Sensor Critical Failure

This is a roll-up status bit that is set
when any of the following critical status
conditions are present:

e Power Accumulator Fault

e Sensor Board Oscillator Failure
e Sensor Code Flow Fault

e Sensor External RAM Failure

e Sensor Internal RAM Failure

e Sensor Flash CRC Failure

e Sensorin Test Mode

e Sensor in Factory Mode

e Sensor in Low Power Mode

o Reference reflection not found

e Sensor Power Supply 2.5V Fault

e Sensor Power Supply 2.5V OSC
Fault

e Sensor Power Supply 3.3V status
Fault

e Sensor NVRAM corrupt

Refer to each condition later in this
table

Power Accumulator
Fault

Power Accumulator board is damaged
or malfunctions.

Power-cycle the device and if problem
persists replace sensing housing... If
problem still persists replace the
terminal block assembly.

Primary Variable Bad

The distance to interface or distance to
product used to derive the Primary
variable is in critical status, the reason
may be loss of echo peak.

Read the Echo curve and check if
valid peaks are detected by device
and stem markers show valid peak
positions. If not configure the
correlation algorithm parameters for
each peak reflections. Ensure the
Dielectric constants configured are
valid for the vapor and products in the
tank.

Sensor Board Oscillator
Failure

If no power accumulator faults are
detected then most likely the sensor
board is damaged/defective.

Power cycle the device if problem
persists replace the Sensor housing.

Sensor Code Flow Fault

The sensor is detecting that the time
between measurements has exceeded
the allowed limit.

Ensure configuration is correct and
restart the sensor. If problem persists,
replacement of the Sensor housing
may be necessary.

Sensor External Ram
Failure

Sensor board external RAM corruption
detected.

Power-cycle the device and see if the
condition re-occurs. If so,
replacement of the Sensor housing is
required.

Sensor Internal Ram
Failure

Sensor board internal RAM corruption
detected.

Power-cycle the device and see if the
condition re-occurs. If so,
replacement of the Sensor housing is
required.

Sensor Flash CRC
Failure

Sensor board firmware has been
corrupted.

Attempt to reload the sensor
firmware. If problem persists after
flashing sensor firmware, replacement
of the Sensor housing is required.

Sensor in Factory Mode

Unit is in factory/test mode.

Power-cycle the device and check if
problem re-occurs.
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Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

Sensor in Low Power
Mode

The sensor is in Low Power Mode
designed to handle low range burnout.

The fault is set if any critical faults are
set and device burnout direction (Fail
safe) is low scale (3.5 mA). Please
perform a hard or soft reset.

Reference reflection not
found

Sensor is not able to detect the
reference refection for level
measurement in direct or remote
mount transmitters or process
connector reflection in remote mount
transmitters.

Upload an echo curve and confirm
that the reference and process
connector (only for remote mount)
model parameters are set for a good
match with actual reflections. Perform
a soft or hard reset.

Sensor Power Supply
2.5V OSC Fault

Power Accumulator board is damaged
or malfunctions.

Power-cycle the device and if problem
persists replace Sensor housing If
problem still persists replace the
terminal block assembly.

Sensor Power Supply
2.5V Fault

Power Accumulator board is damaged
or malfunctions.

Power-cycle the device and if problem
persists replace Sensor housing. If
problem still persists replace the
terminal block assembly.

Sensor Power Supply
3.3V OSC Fault

Power Accumulator board is damaged
or malfunctions.

Power-cycle the device and if problem
persists replace Sensor housing. If
problem still persists replace the
terminal block assembly.

Sensor NVRAM corrupt

Sensor board NVRAM data has been
corrupted.

Use sensor NVRAM corrupt

reset method from host to clear the
sensor NVRAM error.

This method will default the sensor
NVRAM data.

This will reset the critical NVRAM
corruption alarm but the non-critical
not characterized/calibrated alarms
will stay.

If the problem persist then change the
sensor module.

Comm Module Critical
Failure 2

This is a roll-up status bit that is set

when any of the following critical status

conditions are present.

e Program Flow Failure

e Communication Board Vcc ( 3.3V)
Failure

e RAM CRC Failure

¢ RAM Walk Test Failure

e ROM Failure

Refer to each condition later in this
table.

Program Flow Failure

Communication firmware Program
Flow Failure. This fault will get set if
any of the critical part of the code is not
executed after expected duration.

Check if any other faults are reported
like DAC faults, if DAC faults are
reported replace the communication
board. If there are no DAC faults,
check the connection between
communication and Sensor housing.
Power cycle the device and if problem
persists replace the Communication
module.
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Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

Communication Board
Vcece (3.3) Failure

Communication board power supply is
bad.

Power cycle the device. If problem
persist, Check if there are critical
faults related to Power Accumulator
module. If power Accumulator faults
are noticed replace the Sensor
housing and if still problem persists
replace the Terminal block assembly.
If problem continue replace the
Communication module.

RAM CRC Failure

SIL diagnostic failure. Checksum of
critical parameters stored in RAM has
failed.

Power cycle the device. If the problem
persists after power cycle then RAM
might be damaged so need to replace
Communication module.

RAM Walk Test Failure

Communication board RAM Failure.

Power cycle the device. If the problem
persists after power cycle then RAM
might be damaged so need to replace
Communication module. Before
replacing the Communication module
ensure that the device is operating in
environment which falls under the
specifications as mentioned in
SLG700 Transmitter User’s Manual,
#34-SL-25-11.

ROM Failure

Communication board ROM Failure.

Power cycle the device. If the problem
persists after power cycle then RAM
might be damaged so need to replace
Communication module. Before
replacing the Communication module
ensure that the device is operating in
environment which falls under the
specifications as mentioned in the
SLG700 Transmitter User’s Manual,
Document #34-SL-25-11.

Invalid Reference
Plane Offset

Sensor module factory configuration
does not match the application. For
example, sensor module configured in
factory for direct mount used in remote
mount or STSP sensor module used
with HTHP setup.

Replace with sensor module with
matching factory configuration.

Low DC application is
not licensed.

Saturated steam
application is not
licensed.

Interface measurement
is not licensed.

Installed license key does not allow
configured application type.

Update the license key.
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Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

Device Configuration
Failure

This is a roll-up status bit that is set

when any of the following critical status

conditions are present.

e Algorithm Configuration DB
Corrupt

e Common DB Corrupt

e Sensor and Comm. Board DB Data
Mismatch

e Sensor and Comm. Board DB
Version Mismatch

e Sensor Characterization Data
Failure

e Sensor Configuration DB Corrupt

e Sensor Characterization Data
Failure

e Sensor Parameter Write Failure

e Vital Configuration DB Corrupt

e Miscellaneous DB Corrupt

e General Configuration DB Corrupt

e Model Number Mismatch

e License key Errors: include
interface measurement not
licensed, saturated steam not
licensed, single liquid low DC not
licensed and incorrect reference
plane offset.

The following non-critical conditions can
also cause this to be set.

Level linearization table 1 or table 2
corrupted in Communication Board
when linearization is Enabled

Volume Strapping table 1 or table 2
corrupted in Communication Board
when volume calculation type is
Strapping Table

Refer to each condition later in this
table.

Refer to Table 16 - HART Non-Critical
Diagnostic Messages page 67.

Algorithm
Configuration DB
Corrupt

NVM copy of Sensor algorithm
database block found corrupt.

Use clear NVM corrupt method from
host to clear the NVM error.

This method will default the algorithm
block NVM data.

Power cycle the device. If the problem
still persists then NVM might be
damaged so need to replace
Communication board. User may
require to configure the correlation
algorithm parameters if device does
not make valid level measurements.

Revision 6

SLG700 Series HART Option User’'s Manual

Page 63




Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

Common DB Corrupt

NVM copy of Common database block
found corrupt.

Use clear NVM corrupt method from
host to clear the NVM error.

This method will default the common
database block NVM data.

Power cycle the device.

If the problem still persists then NVM
might be damaged so need to replace
Communication module.

Sensor and Comm.
Board DB Data
Mismatch

Comm sensor database Parameter
Inconsistent

Check the cable between
Communication module and Sensor
housing is correct.

Power cycle the device if problem still
persists load the correct
communication and sensor firmware
versions.

Sensor and Comm.
Board DB Version
Mismatch

Communication firmware is not
compatible with sensor firmware.

Update communication and sensor
boards with compatible version of
firmware.

Check with Service person/support
team for version details.

Sensor Characterization
Data Failure

Sensor Characterization Data CRC
corruption

Re-load the sensor firmware and if
problem still persists replace the
Sensor housing.

Sensor Configuration
DB Corrupt

NVM copy of Sensor configuration
database block found corrupt.

Use clear NVM corrupt method from
host to clear the NVM error.

This method will default the sensor
configuration block NVM data.

Power cycle the device. If the problem
still persists then NVM might be
damaged so need to replace
Communication module.

Sensor Parameter Write
Failure

Sensor housing does not have the
latest parameter configuration

Power cycle the device and perform
device configuration again. If problem
still persists load the correct
communication and sensor firmware
versions.

Vital Configuration DB
Corrupt

NVM copy of Vital configuration
database block found corrupt.

Use clear NVM corrupt method from
host to clear the NVM error.

This method will default the
communication module vital block
NVM data.

Power cycle the device. If the problem
still persists then NVM might be
damaged so need to replace
Communication module

Miscellaneous DB
Corrupt

NVM copy of miscellaneous database
block found corrupt.

Use clear NVM corrupt method from
host to clear the NVM error.

This method will default the
communication module miscellaneous
NVM data.

Power cycle the device. If the
problem still persists then NVM might
be damaged so need to replace
Communication module.
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Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

General Configuration
DB Corrupt

NVM copy of general configuration
database found corrupt.

Use clear NVM corrupt method
from host to clear the NVM error.
This method will default the
communication module general
config block NVM data.
Power cycle the device. If the problem
still persists then NVM might be
damaged so need to replace
Communication module.

Model Number
Mismatch

The model number present in sensor
module is different than communication
module

Used Reconcile model number
method from HART host (DTM/DD) to
recover from this fault. Need to select
correct model number either from
sensor module or communication
board module to reconcile. If the both
module model number are not correct
then change the sensor board.

Sensor Comm. Timeout

If there is no communication between
Communication Board and Sensor
Board or invalid data on
communication line due to noise

User can verify the cable/connector
between communication and sensor
board to ensure that it is not
damaged.

Verify by replacing Communication
module If it does not fix the problem,
replace the Sensor Housing.
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Electronic Module
Critical Failure 2

This is a roll-up status bit that is set
when any of the following critical status
conditions are present:

e DAC SPI Interface Failure

e DAC Packet Error

o DAC Over Current

e DAC Under Current

e DAC Temperature Above 140 °C
e DAC Control Word Write Fault

Refer to each condition later in this
table.

DAC SPI Interface
Failure

DAC SPI Interface Failure.

Power cycle the device. Check the
power supply and loop resistance are
within specifications. If they are, then
replace the Communication module.

DAC Packet Error

Packet Error. DAC or microcontroller
chip may be damaged

Check the power supply and loop
resistance are within spec. If they are,
then replace the Communication
module.

DAC Over Current

DAC Over Current. The loop current
value is greater than actual required
value. This might be due to some
component is damaged and taking
more current than expected.

Power cycle the device. If problem
persist, replace the Communication
module or sensing assembly or
terminal block assembly.

DAC Under Current

DAC Under Current. The loop current
value is below the actual required
value.

Power cycle the device. If problem
persist, replace the Communication
module.

DAC Temperature
Above 140 °C

The board temperature is high

Verify the environment is within the
operating specification of GWR
transmitter. If it is, then replace the
Communication module.

DAC Control Word
Write Fault

Control Word Write Fault. DAC or
microcontroller chip may be damaged.

Power cycle the device. If problem
persist, replace the Communication
module.
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6.2.2 Non-Critical Diagnostics
Table 16 lists and describes the HART non-critical diagnostics.

Table 16 - HART Non-Critical Diagnostic Messages

Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

Field Background Not
set

Field background is enabled before
capture.

Capture a new field background and
perform a soft or hard reset.

Field Background Not
compatible

Field background was taken with a
different set of mounting configuration
than the current configuration.

Capture a new field background and
perform a soft or hard reset.

Field background Load
error

Field background could not be loaded
from non-volatile memory.

Capture a new field background and
perform a soft or hard reset.

Device in Power up
mode

This status bit will set at power mode
& it will reset once device found valid
surface/Interface Level.

If the bit is not reset then the check the
echo curve for valid surface or Interface
peaks.

Sensor Failure

This is a roll-up status bit that is set
when any of the following non critical
status conditions are present:

e Sensor Electronic Over
Temperature

e Distance in blocking higher zone

e Distance in blocking lower zone

e Sensor Characterization Status

e Sensor Calibration Status

Refer to each condition later in this
table.

Sensor ET Over
Temperature

Sensor module temperature
exceeded the operating temperature
range specification which is -40 to
+85 Degrees Celsius.

Ensure that the process temperature is
within the operating temperature range
of the transmitter (-40 to +85 Degrees
Celsius). If it is certain that the reading
is in error, the Sensor housing may
need to be replaced.

Interface Distance is in
Higher Blocking Zone

This indicates that interface reflection
has been tracked into the upper zone
near the Reference Plane where
measurements are not accurate.

This is a condition that can occur during
normal operation and does not
generally require corrective action. If
this condition is triggered when it is not
expected, verify that the Blocking
Distance High parameter is set correctly
for the current conditions.

If distance to interface is in Higher zone
then status associated with device
variables derived from distance to
interface will be shown as uncertain in
local display and on HART host the
status would be poor accuracy.

Interface Distance is in
Lower Blocking Zone

This indicates that interface reflection
has been tracked into the lower zone
near the End of Probe where
measurements are not accurate.

This is a condition that can occur during
normal operation and does not
generally require corrective action. If
this condition is triggered when it is not
expected, verify that the Blocking
Distance Low parameter is set correctly
for the current conditions.

If distance to interface is in Lower zone
then status associated with device
variables derived from distance to
interface will be shown as uncertain in
local display and on HART host the
status would be poor accuracy.
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Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

Surface Distance in
Blocking Higher Zone

This indicates that either the surface
or interface reflection has been
tracked into the upper zone near the
Reference Plane where
measurements are not accurate.

This is a condition that can occur during
normal operation and does not
generally require corrective action. If
this condition is triggered when it is not
expected, verify that the Blocking
Distance High parameter is set correctly
for the current conditions.

If distance to product is in Higher zone
then status associated with device
variables derived from distance to
product will be shown as uncertain in
local display and on HART host the
status would be poor accuracy.

Surface Distance in
Blocking Lower Zone

This indicates that either the surface
or interface reflection has been
tracked into the lower zone near the
End of Probe where measurements
are not accurate.

This is a condition that can occur during
normal operation and does not
generally require corrective action. If
this condition is triggered when it is not
expected, verify that the Blocking
Distance Low parameter is set correctly
for the current conditions.

If distance to product is in Lower zone
then status associated with device
variables derived from distance to
product will be shown as uncertain in
local display and on HART host the
status would be poor accuracy.

Sensor
Characterization Status

This indicates that device is not
characterized, this has an impact on
accuracy of device measurements at
different temperatures.

Replace the Sensor housing with
characterized Sensor housing and send
the un characterized device to factory.

Sensor Calibration
Status

This indicates device is not calibrated
and impacts the accuracy of
measurements at different positions
of level

Replace the Sensor housing with
calibrated Sensor housing and send the
non-calibrated device to factory.

Electronic Module
Comm Failure

This is a roll-up status bit that is set
when any of the following non critical
status conditions are present:

e DAC Temperature above 100 °C
e Config change database block is
corrupted in Communication

board.

e Advance diagnostics database
block is corrupted in
Communication board

e Brownout Status.

Refer to each condition later in this
table.

DAC Temperature
Above 100 °C

The communication board
temperature is high above 100 °C.

Check the ambient temperature and if
ambient temperature is well below 100
deg C, check if there are other DAC
faults reported by device. Power cycle
the device and if error still persists
replace the Communication module.
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Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

Config Change DB
corrupt

NVM copy of Configuration history
database block found corrupt.

Use clear NVM corrupt method
from host to clear the NVM error.

This method will default the
communication module config
change NVM data.

Power cycle the device.

If the problem still persists then NVM
might be damaged so need to replace
Communication module.

Adv Diag DB RAM
corrupt

Communication board RAM copy of
Advanced diagnostics database block
found corrupt.

Power cycle the device.

If the problem still persists then RAM
might be damaged so need to replace
Communication module

Brownout Status

This indicates that device is reset due
to fluctuations in supply voltage of
communication board.

Verify the supply voltage to transmitter
and loop resistance and any noise
source near transmitter. Power cycle
the device and if problem still persists
then replace Communication module.

Local Display Failure

This is a roll-up status bit that is set
when any of the following critical
status conditions are present.

e Meter (Display) Timeout
e Display NVM Corrupt
e Display Viewl corrupt
e Display View2 corrupt
e Display View3 corrupt
e Display View4 corrupt
e Display View5 corrupt
e Display View6 corrupt
e Display View7 corrupt
e Display View8 corrupt

Refer the resolution column
corresponding to respective non critical
status conditions.

Meter (Display)
Timeout

Display module not connected
properly to Comm module or the
interface connector or hardware of
either Comm module or display
module is damaged.

Power cycle the device and check the
local display connectivity. Secure
Display connections and recheck

Refer to Maintenance in User manual
34-SL-25-11 for more details about how
to connect the display module with
Communication module.

If problem still persists, replace the
display module

Display NVM Corrupt

Display configuration data has been
corrupted.

Use clear NVM corrupt method from
host to clear the NVM error.

This method will default the Display
general configurtaion NVM data.

Power cycle the device. Reconfigure
Display general configuration like
screen rotation, language and
password. If individual views are
corrupted then reconfigure the
corresponding view that is defaulted.
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Name (DTM/DD) Description (Cause) Resolution (Steps to take)

Display Viewl corrupt Display Viewl database block found Use clear NVM corrupt method from
corrupt. host to clear the NVM error.

This method will default the Display
viewl NVM data.

Power cycle the device. User will need
to reconfigure Display viewl.

Display View2 corrupt Display View2 database block found Use clear NVM corrupt method from
corrupt. host to clear the NVM error.

This method will default the Display
view2 NVM data.

Power cycle the device. User will need
to reconfigure Display view2.

Display View3 corrupt Display View3 database block found Use clear NVM corrupt method from
corrupt. host to clear the NVM error.

This method will default the Display
view3 NVM data.

Power cycle the device. User will need
to reconfigure Display view3.

Display View4 corrupt Display View4 database block found Use clear NVM corrupt method from
corrupt. host to clear the NVM error.

This method will default the Display
view4 NVM data.

Power cycle the device. User will need
to reconfigure Display view4.

Display View5 corrupt Display View5 database block found Use clear NVM corrupt method from
corrupt. host to clear the NVM error.

This method will default the Display
view5 NVM data.

Power cycle the device. User will need
to reconfigure Display view5.

Display View6 corrupt Display View6 database block found Use clear NVM corrupt method from
corrupt. host to clear the NVM error.

This method will default the Display
view6 NVM data.

Power cycle the device. User will need
to reconfigure Display view®6.

Display View7 corrupt Display View7 database block found
corrupt. Use clear NVM corrupt method from
host to clear the NVM error.
This method will default the Display
view7 NVM data.
Power cycle the device. User will need
to reconfigure Display view?7.
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Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

Display View8 corrupt

Display View8 database block found
corrupt.

Use clear NVM corrupt method from
host to clear the NVM error.
This method will default the Display
view8 NVM data.
Power cycle the device. User will need
to reconfigure Display view8.

Device Variable Not
Supported

This condition indicates that one of
the Dynamic Variables is mapped to a
Device Variable that is not supported
by the current Measured Product.
This condition is considered non-
critical for the SV, TV and QV
Dynamic Variables. However, if this
condition is true for the PV Dynamic
Variable, then the critical
Measurement Failure condition will
also be set.

Reconfigure the dynamic variables PV,
SV, TV and QV correctly for the
configured measured product type. See
page 19.

Volume Calculation
Failure

This condition indicates that one of
the Dynamic Variables is mapped to a
Device Variable that calculates a
volume and the volume calculation
failed. This condition is considered
non-critical for the SV, TV and QV
Dynamic Variables. However, if this
condition is true for the PV Dynamic
Variable, then the critical
Measurement Failure condition will
also be set.

Verify the strapping table data or the
dimensions of ideal tank shape.

Linearization Table
Error

This condition indicates that one of
the Dynamic Variables is mapped to a
Device Variable that is derived from a
linearized level measurement and the
corrected level calculation failed. This
condition is considered non-critical for
the SV, TV and QV Dynamic
Variables. However, if this condition is
true for the PV Dynamic Variable,
then the critical Measurement Failure
condition will also be set.

Ensure that the Level linearization table
has at least two entries, that the entries
in both measured and corrected level
columns are in Ascending or
descending order and also all of the
entries are within the range specified by
the measurement configuration
parameters.

Linearization Table 1
Config DB corrupt

NVM copy Level linearization table-1
database block found corrupt.

This non critical alarm can occur even
linearization is disabled

Use clear NVM corrupt method from
host to clear the NVM error.

This method will default the
Linearization table NVM data.

Power cycle the device. If the problem
still persists then NVM might be
damaged so need to replace
Communication module. User may
require to configure Linearization table
again for his application.
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Name (DTM/DD) Description (Cause) Resolution (Steps to take)

Linearization Table 2 NVM copy of Level linearization table- Use clear NVM corrupt method from
Config DB corrupt 2 database block found corrupt. host to clear the NVM error.
This non critical alarm can occur even This method will default the
linearization is disabled Linearization table NVM data.

Power cycle the device. If the problem
still persists then NVM might be
damaged so need to replace
Communication module. If problem
does not re-occur, device parameters
part of this block are re-stored to default
values. User may require to configure
Linearization table again for his

application.
Volume Strapping NVM copy of Volume strapping table- Use clear NVM corrupt method from
Table 1 Config DB 1 database block found corrupt. host to clear the NVM error.
corrupt This non critical alarm can occur This method will default the Volume
irrespective of Volume calculation strapping table NVM data.
type
Power cycle the device. If the problem
still persists then NVM might be
damaged so need to replace
Communication module. If problem
does not re-occur, device parameters
part of this block are re-stored to default
values. User may require to configure
Strapping table again for his application.
Volume Strapping NVM copy of Volume strapping table- Use clear NVM corrupt method from
Table 2 Config DB 2 database found corrupt. host to clear the NVM error.
corrupt This non critical alarm can occur This method will default the Volume
irrespective of Volume calculation strapping table NVM data.
type
Power cycle the device. If the problem
still persists then NVM might be
damaged so need to replace
Communication module. If problem
does not re-occur, device parameters
part of this block are re-stored to default
values. User may require to configure
Strapping table again for his application.
No DAC Compensation | Communication board DAC Replace Communication module to
compensation is not performed... achieve the maximum current loop
Loop accuracy may be slightly accuracy and return the device to
compromised. Effect will be minor factory for DAC compensation.

degradation of ambient temperature
influence specifications.

Unreliable Sensor Communication between sensor and Verify the cable/connector between

Communication communication modules is not proper | communication and Sensor housing to
due to damaged connector or ensure that it is not damaged.
hardware issue with Comm module or | Either the transmitter is installed in a
sensor module noisy environment or internal

communication quality between the
Electronics Module and Sensor is
degrading. Try replacing either
Communication module or Sensor
housing.
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Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

PV Out of Range

PV value is not within LRV and URV

Check if digital value of PV is out of
configured LRV and URV.

Read the echo curve to see if stem
markers are valid for distance to product
and distance to interface (if applicable
based on measured product type).

If PV selected is derived from either
strapping table or Linearization table,
check the tables for valid entries.

Fixed Current Mode

Output current is fixed and not
varying as per input.

Loop current mode is disabled or
Loop Test is active.

This is information to user.

Enable loop current mode if it is
disabled or exit the Loop Test mode if
active

Low Supply Voltage
(DAC)

Incorrect supply voltage at the
transmitter terminals.

Check the power supply and loop
resistance are within specification or
not. If they are correct, then replace the
terminal block assembly.

Device Variable Out Of
Range

User can notice this alarm if the
distance to the interface is bad but
device variable selected as PV is
derived from distance to product

Read the Echo curve and verify valid
stem markers for distance to interface,
and configure the correlation algorithm
parameters for interface peak

which is valid. reflections.
Tamper Alarm The Tamper Alarm is set if more than See page 32 for Tamper Alarm
a specified number of attempted or configuration.

actual configuration changes are
made, when Tamper Alarm is
Enabled ( Device can be either Write
Protected or not ). The warning stays
active until the specified latency
period has elapsed.

Sensor in Sleep Mode

Sensor in Sleep Mode due to
Configuration Change.

Sensor module adjusting model
parameters and waiting for sufficient
power to measure level.

Power cycle the device and if problem
persist for more than 4 minutes replace
the Sensor housing

Loop Current Noise

DAC Not able to regulate loop
current. If this condition is observed
frequently, it could be an early
indication of critical under or over-
current failure.

Try to find the source of the noise. It
could be bad loop wires, a hardware
problem inside the transmitter, loop
wires running close to a noise source
etc. If the environment is ok, replace the
Electronics Module.

AO Saturated

Calculated analog output is either
above or below the specified loop
current limits (LRV and URV).

Verify that the LRV and URV values are
in specified range or not.

Check if distance to product or distance
to interface is in blocking zones.

URYV Set Error - Span
Config Button

Set operation using external Span
button was rejected.

Please check whether the inputs are
valid for the intended operation.

LRV Set Error - Zero
Config Button

Set operation using external Zero
button was rejected.

Please check whether the inputs are
valid for the intended operation.

Surface signal quality
bad

Surface signal quality is bad.

Read the Echo curve and configure
algorithm and DC parameters
accordingly using the DTM.

Surface signal strength
bad

Surface signal strength is weak

Read the Echo curve and configure
algorithm and DC parameters
accordingly.
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Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

Interface signal quality
bad

Interface signal quality is bad.

Read the Echo curve and configure
algorithm and DC parameters
accordingly.

Interface signal
strength bad

Lower product signal strength is
weak.

Read the Echo curve and configure
algorithm and DC parameters
accordingly.

Sensor Configuration
DB RAM Corrupt

RAM copy of Sensor configuration
database block found corrupt.

Power cycle the device

Strapping/Linearization
Table Absent

1. If linearization table is not available
in communication board NVM when
level linearization is enabled

2. If strapping table is not available
when volume calculation type is
Strapping table.

Configure the Linearization table before
level linearization is enabled. Configure
the Strapping table to select Volume
calculation type “Strapping table”.

Display Common
Config DB corrupt

NVM copy of Display general
parameters database block found
corrupt.

Use clear NVM corrupt method from
host to clear the NVM error.

This method will default the Display
common NVM data.

Power cycle the device and re-configure
display configuration if required.

Display View Config
DB corrupt

NVM copy of Display view/screen
configuration database block found
corrupt.

Use clear NVM corrupt method from
host to clear the NVM error.

This method will default the Display
view data.

Power cycle the device and re-configure
display configuration if required.

Display Common DB
RAM Corrupt

RAM copy of display general
parameters database block found
corrupt.

Power cycle the device and re-configure
display configuration if required.

Display View DB RAM
Corrupt

RAM copy of display view/screen
configuration database block found
corrupt.

Power cycle the device and if problem
still persists replace the Communication
module.

Adv Diag DB RAM
corrupt

RAM copy of advanced diagnostics
database block found corrupt

Power cycle the device and if problem
still persists replace the Communication
module.

Config Change DB
RAM corrupt

RAM copy of configuration history
database block found corrupt.

Power cycle the device and if problem
still persists replace the Communication
module.

General Config DB
RAM corrupt

RAM copy of general configuration
database block found corrupt.

Power cycle the device and if problem
still persists replace the Communication
module.

Vital Configuration DB
RAM Corrupt

RAM copy of Vital configuration
database block found corrupt

Power cycle the device and if problem
still persists replace the Communication
module.

Common DB RAM
Corrupt

RAM copy of Common database
block found corrupt.

Power cycle the device and if problem
still persists replace the Communication
module.

Miscellaneous DB RAM
Corrupt

RAM copy of Miscellaneous database
block found corrupt.

Power cycle the device

If the problem persists even after power
cycle then Communication module
needs to be changed.
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Name (DTM/DD)

Description (Cause)

Resolution (Steps to take)

Linearization Table 1
Config DB RAM corrupt

Level linearization table 1 RAM copy
of database block found corrupt.

This non critical alarm can occur even
linearization is disabled

Power cycle the device and if problem
still persists replace the Communication
module.

Linearization Table 2
Config DB RAM corrupt

Level linearization table 2 RAM copy
of database block found corrupt.

This non critical alarm can occur even
linearization is disabled

Power cycle the device and if problem
still persists replace the Communication
module.

Volume Strapping
Table 1 Config DB
RAM corrupt

RAM copy of Volume strapping table
1 database block found corrupt.

This non critical alarm can occur even
volume calculation type is none

Power cycle the device and if problem
still persists replace the Communication
module.

Volume Strapping
Table 2 Config DB
RAM corrupt

RAM copy of Volume strapping table
2 database block found corrupt.

This non critical alarm can occur even
volume calculation type is none

Power cycle the device and if problem
still persists replace the Communication
module.

Sensor Algorithm
Config DB RAM
Corrupt

Sensor algorithm RAM copy of
database block found corrupt.

Power cycle the device and if problem
still persists replace the Communication
module.
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7 HART DD binary file format compatibility matrix

Table 17: HART DD Compatibility Matrix

"Host - SLG700 - HART DD binary file format" compatibility matrix

Host DD file format to be used
Experion R410 and above Fm8

versions

Experion R400 to R300 Fm6

Experion below R300 Fms

FDM R430 and above Fm8

versions

FDM R410 - R302 Fm6

FDM Below R302 Fms

ﬂ Refer the respective Tools’ User Manual for details on loading the DD file on these
Tools.

7.1 HART DD files — Download

Go to:

https://www.honeywellprocess.com/en-US/support/Pages/all-downloads.aspx

Type in SLG700 in the Search field.

The results will show an entry similar to the one below:

HART Device Description (DD) files for Honeywell HART Devices

This .zip file contains the latest version of the DD files for all of Honeywell's HART field devices.
Unzip the file to locate the DD files applicable to the SLG700 series.
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8 Using DTMs

8.1 Introduction

A DTM is an application that that can detect and utilize the services provide by vendor supplied
device and communication DTMs to facilitate configuration and monitoring of devices such as
HART commands that the SLG Level transmitter supports. To set up the DTM network on the
FDM/Experion, refer to the FDM/Experion User Guide. In this manual, the procedure is given to
run the SLG700 HART DTM on PACTware (Version 4.1 or above).

8.2 Components
To be able to use the HART DTM the user needs the following:

1. PACTware or some other FDT Container application.

2. Microsoft .NET Framework 2.0

3. The latest HART Communication DTM.

4. The “Honeywell SLG700 HART DTM* which is separate from the library of DTMs
supplied by CodeWrights which contains the DTMs for all of the other SmartLine

transmitters.

5. A HART modem, which is available with RS-232 or USB serial interfaces for connection
to a PC.

8.3 Downloads

e Download 1: PACTware 4.x and .NET 2.0
Download from http://pactware.software.informer.com/download/

e Download 2: HART Communication DTM
Download from http://www.codewrights.biz/

e Download 3: Honeywell SLG700 HART DTM (see item 4 above)

Download from HPS web site: https://www.honeywellprocess.com/smatrtline-level-
transmitter.aspx

8.4 Procedure to Install and Run the DTM

1. Install the Downloads 1, 2, and 3 above.

Connect the Transmitter to the DC power supply with at least 250 ohm loop resistance.
The voltage at the Transmitter terminals must be at least 14 V.

3. Connect the HART modem terminals to the Transmitter LOOP +/- terminals, or across
the HART load resistor.

4. Connect the HART modem serial or USB connector to a PC COM port.

5. Run PACTware and select the Device Catalog option on the Window menu. The Device
Catalog window should open to the right-hand side of the display.

6. Click on the Update Device Catalog button at the bottom of the Device Catalog window
and click on Yes in the confirmation pop-up window. Make sure that the SLG700 HART
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Rev 4 Device DTM shows up in the catalog. Note: With PACTware, this update
procedure may need to be repeated a couple of times.

7. Select the Project option on the Window menu to close the Device Catalog window and
select the top level of the project view, which may be labeled HOST PC.

8. Right click on the top level item in the project tree and select Add Device from the context
menu. In the device pop-up window select the HART Communication device and click on
the OK button at the bottom of the window.

9. Right click on the added HART communication DTM in the project menu and select
Parameter from the context menu.

10. In the HART Communication DTM's Parameter window, click on the Serial Interface pull-
down menu and select the correct port that the HART modem has been connected to,
then click on the OK button in the lower right-hand corner.

11. Right click on the HART Communication DTM in the project view and select Add Device

from the context menu. In the device pop-up window select the SLG700 HART device
that matches the transmitter model, SLG700 HART Rev 1, SLG700 HART Rev 2,
SLG700 HART Rev 3 or SLG700 HART Rev 4. Click on the OK button at the bottom of
the window.

12. Right click on the SLG700 HART device in the project menu and select Connect from the
context menu. After a few seconds the device label should turn to bold.

13. Right click on the SLG700 HART device in the project window and select
Parameter—Online Parameterization from the context menu. The SLG700 Welcome
screen will be displayed while the DTM is reading some basic configuration parameters
from the transmitter.

14. When the initial reading of data is completed the Welcome display will provide 3 options
to advance to the main menu items. If familiar with the device, select proceed to
Advanced Setup. Browse through the menus to access various parameters/functions.

8.5 SLG700 Online Parameterization

The following sections provide a high-level overview of SLG700 DTM screens.

e Guided setup takes the user step by step through the Basic Configuration, page 79.
e Advanced Setup goes to Advanced Configuration tab, page 95.
e Dashboard goes to the Monitor tab, page 129

8.6 DTM Help
Mouse over the symbol next to a parameter to read its description. On some pages the user
Page Hel
can click on age mep if available.
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8.7 Configuring the Transmitter

8.7.1 Basic Configuration

Note:

The DTM version offers two setup options: Guided and Unguided.
The local display and DD version do not offer a guided setup option.

Completion of the Basic Configuration is a quick way to start operating the SLG700 transmitter in
most applications. This configuration consists of only few steps and the Guided Setup option,
available from the Welcome page, is provided to step the user through the various menu items in
this configuration category. After completing the Guided Setup process the Basic Configuration
menu can be revisited at any time by selecting Basic Configuration from the top three menu
buttons, as shown below in Figure 5.

The Basic Configuration menu groups the most commonly modified parameters into five
categories; General, Process, Measurement, Dynamic Variables, and 4-20mA Outputs. The
parameters in these groups address the major site-specific configuration that might be needed
during the commissioning of a transmitter. When accessing the display for each of these groups
through the Basic Configuration menu there are a few additional parameters available that are not
present when accessing these displays through the Guided Setup mode.

Honeywell

Short Tag

Long Tag

Default Units

Message (on LCD)

Basic Advancad = st eiis L 20mA
Configuration JESTRTHVEIEE] et b 0K 2 m 48 mA

Metnc us | Impenal E
Distance m
Temperature c
Velocity m's v
Volume m*

Figure 5: Basic Configuration - General

Revision 6

SLG700 Series HART Option User’'s Manual

Page 79




8.7.2 General
This group contains some parameters to allow the device to be identified.

There is an additional parameter that allows the user to enter a message that will be displayed on
the local display. This parameter is not available when the General parameters are being entered
in the Guided Setup mode but it is available if the page is visited in the unguided mode, as shown
in Figure 5.

Short Tag: A tag used to identify or characterize the transmitter with a maximum of 8
characters from the HART Packed ASCII character set.

Note: The HART Packed ASCII character set is a subset of the ASCII
character set that is limited to the following characters:

ABCDEFGHIJKLMNOPQRSTUVIWXYZ@[\]~_
0123456789:;<=>? "#$%&' ()*+,-./
Characters not included in this character set will not display.

Long Tag: Allows the entry of a longer tag with a maximum of 32 characters from the
(ISO Latin 1 character set).
Default Units: This sub-menu item allows selection of the units to be used for the four
physical properties applicable to the transmitter. All configuration parameters or process
output variables for a given property will be displayed in the selected units. The available
options are:

Distance: mm, cm, m, in, ft

Temperature: °C, °F

Velocity: m/s, m/h, in/s, in/min, ft/s, ft/min

Volume: |, m3, in3, ft3, yd3, US gal, US bbl (lig), US bbl (oil), imp gal

Note: For the HART DTM interface, clicking on the Metric, U.S. or Imperial
buttons is only used to pre-select a set of values. Individual units can be
selected from different measurement systems if this is desirable.
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8.7.3 Process

The five parameters in this group allow the products involved in the process of operating
the tank to be identified, as shown below in Figure 6. The first consideration to be made
is the number of products involved, and secondly the dielectric constant of each product.
The dielectric constant of a medium affects radar measurements in two ways:

1. Pulses travelling through a medium are slowed by an amount related to the
dielectric constant.

2. The relative amount of the original pulse that is reflected from the boundary
between two mediums is related to the dielectric constants of the media on each
side of the interface. For the reflected pulse, the reduction in the amplitude with
respect to the original pulse amplitude can be calculated from the dielectric
constants of the media on each side of the interface.

Common dielectric constants can be found from the pull-down lists. If a material is
not present on the list or if the dielectric constant is not correct, the correct value can
be entered in the corresponding textbox.

Honeywell Basic Advancec
Smartl Suided Wave Radar Configuration &)

atus PO 4. 20mA
0K 19.9 mA

Genera Process Measurement I Dynamic Vanables 4-20mA Outputs I Summary

Measured Products
Two Liquids, Non-Flooded ~ @

Vapor Dielectric Constant
1.000

Vapor
Upper Product Dielectric Constant

20.000 Select rom kst Upper Product

Lower Product Dielectric Constant
60.000  Selectfom kst

Lower Product

Maximum Filling Rate
0.040 m/s

dp Disconnected _Q_ Dewice i Offine Planning Engineer

Figure 6: Basic Configuration — Process
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Measured Products
This configuration parameter allows the number and type of products in the tank to be identified.
This determines the various reflections that the transmitter will search for, how they will be used
and the number of output variables calculated.

Note:

Starting with the R200 release (HART Device Revision 4), advanced
applications of the transmitter require the purchase of the
corresponding software license, so not all the selections listed below
will be available in all cases. Refer to SLG Transmitter User's Manual
#34-SL-25-11 for more information on purchasing additional software
licenses.

Single Liquid: In this application, the SLG700 measures the level of one liquid product in the
tank with a vapor, which is usually air, above the product. This application is always available
and is shown in Figure 7.

2

Vapor

1
Product Level
Product

Figure 7: Single Liquid Application

Two Liquids Flooded: In this application, there are two liquid products in the tank; one
supported on top of the other, as shown below in Figure 8. As the name indicates, the
tank is always full with the Upper Product occupying the entire upper portion of the tank
so that there is no vapor above the Upper Product. The SLG700 measures the level of
the interface (boundary) between the two liquid products in the tank.

Note:

This application requires the Interface Measurement software license.
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Upper Product

Interface Level Lower Product

Figure 8: Two Liquids Flooded Application

Two Liguids Non-Flooded:In this application there are also two liquid products in the
tank, however, the tank is not normally full so that there is a vapor above the Upper
Product, as shown below in Figure 9. The SLG700 measures the total level of the
products in the tank as well as the level of the interface (boundary) between the two liquid
products in the tank. While both level measurements (or derived measurements such as
upper and lower product volumes) are available for monitoring through the HART digital
interface, only one measurement can be assigned to provide the analog loop current
signal to a control system.

Note: This application requires the Interface Measurement software license.

¥

Vapor

1
Product Level Upper Product

Interface Level Lower Product

Figure 9: Two-liquid Non-flooded Application
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Note: license and is only available for the SLG726 high temperature and

Note: This application requires the Low DC Application software license.

Saturated Steam: Sensor revision R200 introduced a new application type, the level of
water level in steam boilers. This application is similar to the Single Liquid application
shown in Figure 7, however, unlike regular single liquid measurement applications where
the medium above the liquid has a constant dielectric constant, the steam inside a boiler
has a dynamic dielectric constant which varies with the steam pressure and temperature.
To measure the resulting varying speed of the radar pulse, the measurement rod is
extended to include a reference reflector that sits above the measurement area.

This application requires the Saturated Steam Application software

pressure transmitter model.

Single Liquid, Low DC: R200 introduced a new measurement technique that can be
helpful when the surface reflection is either very small or otherwise unstable. This
application is similar to the Single Liquid application shown in Figure 7, however, the low
dielectric constant of the medium makes it transparent enough that the sensor can
always detect the pulse reflected at the end of the probe. The apparent shift of the end of
probe signal when the product level rises is used to calculate the level of the surface.
This technique requires precise knowledge of both the probe length and the dielectric
constant of the medium.

Vapor Dielectric Constant
Depending on the selection above, the user interface allows users to enter values for the dielectric

constant

(DC) for each of the products present, as shown in Table 18.

Table 18 - Dielectric Constants Required by Application

Single Liquid and Two Liquid Non-Flooded | Two Liquid Flooded
Single Liquid, Low DC

Vapor DC Vapor DC

Product DC Upper Product DC Upper Product DC

Lower Product DC Lower Product DC

Note:

The

For the Saturated Steam application, none of the dielectric constants
can be entered by the user as they are dynamically calculated.

dielectric constant of most gasses is very close to 1.0 and the Vapor Dielectric Constant

parameter will most often not need to be edited. Enter the correct value if it is significantly

diffe

rent than 1.0.
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Upper/Lower Product Dielectric Constants

For liquid products the dielectric constants vary much more. For the two liquid applications, Two
Liquids Flooded and Two Liquids Non-Flooded, the value entered for the Upper Product Dielectric
Constant will have a significant impact on the accuracy of the reported Interface Level. Entering of
the correct value for the DC of the Upper Products ensures accurate measurement of the
Interface, because the speed of the measuring signal varies with the DC of the Upper Product.

To aid in the selection of the correct DC value for the liquid products, the DTM offers the ability to
select the product type from a list that will automatically populate the DC entry field. Click on the
Select from list... option, as shown in Figure 6. After selecting a product from the list the DC
value can still be edited manually if needed.

Maximum Filling Rate

This parameter indicates the maximum rate at which the tank is expected to be filled or emptied.
This allows the transmitter to collect data over the correct area of the probe so that the surface
and/or interface positions can be tracked effectively and aids in the rejection of false reflections
that might look similar to the correct reflections. The valid range is between 0.04-0.9 m/s (0.1312-
0.656 ft/s). The sensor uses this value to discard erroneous echoes. It is recommended that a
value somewhat larger than that expected from typical fill and draining operations is entered,
typically at least 0.1 m/s.

If the maximum filling rate is exceeded, the transmitter will continue to search for it in a narrow
region until the echo-lost timeout is expired. The transmitter will then enter a measurement fault
condition and search for the level over the entire probe length.

Note that if the rate of change is greater than 0.9 m/s, the transmitter will likely not track the level
and only a level lost fault condition is set, without the ROC alarm. If the measurement is outside
the blocking zones the transmitter will display a measurement fault until the echo lost timeout
period has been exceeded, and then it will search for the level again. If it starts in a blocking
distance position, it will stay in the blocking distance until the level reappears within the distance
allowed by the ROC limit. However, as of R200, if the level appears suddenly outside of blocking
distance, failing ROC a level lost fault condition is set and output is maintained at the value of the
blocking zone. This change has important consequences if latching mode is not set.
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8.7.4 Measurement

The GWR transmitter inherently measures the time of flight of radar pulses that reflect off the
boundary between two different mediums. This time is first transformed into a measure of the
distance between a fixed point on the transmitter body, referred to as the Reference Plane, and
the boundary between the two mediums. The Reference Plane has been chosen to be a flat
machined surface near the probe connection point.

Figure 10 shows the location of the Reference Plane, denoted as R, for the two basic methods of
connecting the transmitter to the tank, either threaded or flanged. Refer to the Radar Level
Measurement section in the SLG700 Transmitter User’s manual #34-SL-25-11.

e
(R0

», > |
i /\ W\
vy

A e

;

B S—l
Flanged Threaded

Figure 10: Reference plane R for flanged and threaded connections

Most users are more interested in the height of the liquid surface or interface relative to some
lower datum point, such as the bottom of the tank, rather than the transmitter’s reference plane.
Measurements made relative to this lower, user-defined datum point are referred to as levels to
distinguish them from the distances measured from the transmitter's datum point. In order to
convert distance measurements to level measurements, the following parameters are used to
describe the geometry of the installation:
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Sensor Height (A)

Level Offset (C)

Maximum Product Level (B)

Probe Length

Rp Disconnected | Gl Device | (@ Offiine

Honeywell Basic Advanced
SmartLine Guided Wave Radar [T TETOIE Configuration

General l Process Measurement Dynamic Vanables 4-20mA Outputs

Status

Monitor > b

0.20m

1.100 m

4.20mA

4.8 mA

l Summary

0.000 m l |

T oo
1.000 m

1.000 m

Planning Engineer

Sensor Height (A)

Figure 11: Basic Configuration — Measurement

Height of the transmitter's Reference Plane above some user-defined fixed bottom
reference plane. This fixed bottom reference plane should be a location from which
accurate measurements to the transmitter's Reference Plane can be obtained. It may be
the bottom of the vessel but it may also be the ground or other convenient location and
does not necessarily have to be the plane that represents a level of 0.0.

Level Offset (C)

The distance between the user-defined reference plane and the plane that represents a
level of 0.0. This offset may be positive (upward), negative (downward) or zero if it

coincides with the user-defined reference plane. This offset defines the zero point for the
transmitter's level measurements.

Maximum Product Level (B)

The maximum level reading, in length units, above the Level Offset point that is expected
when the tank is considered full. This parameter is used primarily to allow the level to be
reported in units of % as well as in the specified length units.
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Figure 12- Distance to level conversion dimensions

Probe Length

The distance from the transmitter’s Reference Plane to the end of the probe. This
parameter is normally entered by the factory based on the model number ordered and
does not need to be changed. See SLG700 Transmitter User’s manual #34-SL-25-11 for
trimming probes.

e For coax probes and rod probes without a centering disk the distance to enter is the
distance to the physical end of the probe.

e For rod probes with a centering disk attached the distance to the top surface of the
disk should be entered.

e For wire probes with an end-weight attached it should be the distance to the top of
the end weight.
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8.7.5 Dynamic Variables

In addition to converting the time of flight of reflected radar pulses into a measure of distance, the
SLG700 transmitter can calculate a number of related process measurements, such as volume. In
many control systems, these measurements are referred to simply as process variables, however,
in the terminology of the HART protocol they are referred to as Device Variables. In total 15
different process calculations are supported as outlined in Table 19.

Table 19 - Device variables

Device Variables Device Supported Units
Variable
code
Product Level 0 ft, in, m, cm, mm
Product Level % 1 %
Distance to Product 2 ft, in, m, cm, mm
Product Level rate 3 ft/s, m/s, in/min, m/h, ft/min, in/sec
Product Volume 4 ft3, in3, US gal, Imp gal, barrels, yd3, m3, liters, bbl lig
Vapor Thickness 5 ft, in, m, cm, mm
Vapor Thickness % 6 %
Vapor Volume 7 ft3, in3, US gal, Imp gal, barrels, yd3, m3, liters, bbl lig
Interface Level 8 ft, in, m, cm, mm
Interface Level % 9 %
Distance To Interface 10 ft, in, m, cm, mm
Interface Level Rate 11 ft/s, m/s, in/min, m/h, ft/min, in/sec
Upper Product Thickness 12 ft, in, m, cm, mm
Lower Product Volume 13 ft3, in3, US gal, Imp gal, barrels, yd3, m3, liters, bbl lig
Upper Product Volume 14 ft3, in3, US gal, Imp gal, barrels, yd3, m3, liters, bbl lig

In each installation, however, the actual number of measurements available is dependent on the
application and optional settings such as the additional configuration required for volume
measurements, as shown in Table 20.

Table 20 - Device variables according to measured product type

Single Liquid Two Liquid Flooded Two Liquid Non -Flooded
Single Liquid, Low DC
Saturated Steam

Product Level Intf Level Product Level

Prod Level % Intf Level % Prod Level %

Dist To Prod Dist To Intf Dist To Prod

Prod Lvl Rate Intf Lvl Rate Prod Lvl Rate

Product Volume? Upr Prod Thick Product Volume?

Vapor Thick Lower Prod Vol* Vapor Thick
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Vapor Thick % Upper Prod Vol* Vapor Thick %

Vapor Volume?! Vapor Volume?

Intf Level

Intf Level %

Dist To Intf

Intf Lvl Rate

Upr Prod Thick

Lower Prod Vol!

Upper Prod Vol*

1The highlighted Volume measuring values are available only after activating the Volume
calculation, the method for Volume calculation has been selected and relevant tank data entered
by the user. This can be done through the Advanced Configuration menu, section 8.8.

In addition to the Device Variables, the HART protocol has a concept of Dynamic Variables which
allows up to four Device Variables to be configured for possible connection to an analog output
channel and for access by a smaller more widely implemented command set.

These Dynamic Variables are referred to as:

e Process Variable (PV)

e Secondary Variable (SV)
e Tertiary Variable (TV)

e Quaternary Variable (QV)

Of the variables, the PV is unique as it is always assigned to the analog output channel that drives
the loop current which may be monitored by the control system.

The DTM allows device variables to be assigned to the 4 Dynamic Variables, as shown below in
Figure 13.

Honeywell Basic Advanced | 0o Status 4-20mA
SmartLine Guided Wave Radar (OLILNIENGLE Configuration R 0K 0 / 3 4.8mA

General I Process l Measurement Dynamic Variables 4-20mA Outputs Summary

Measured Products Single Liquid

Primary Variable (PV) and Distance to Product -
Loop Current

Secondary Variable (SV) Product Level v
Tertiary Variable (TV) Product Level -
Quaternary Variable (QV) Product Level v
Rp Disconnected | @, Device | Offiine Planning Engineer

Figure 13: Basic Configuration - Dynamic Variables
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8.7.6 4-20 mA Outputs Configurations

The digital value calculated by the transmitter for the Primary Variable, be it a distance, volume or
percent, must be conveyed to the control system as an analog signal by adjusting the amount of
current flowing in the loop connecting the two components. This is done by a linear mapping of a
range of the Primary Variable scale to the 4-20 mA scale of the loop current. This mapping can be
adjusted via the controls shown in Figure 14 below.

g SLG700 HART Parameter

Honeywell Basic A 4 20mA
s Wave Rada Configuration JK#8 oK - 48mA
TR ] Procest ! Measurement |  Dynamic vanabies 4:20mA Outputs
Upper Range Value (20 mA) 4000 m PV, Loop Current = Distance to Product

Loop Current:

Lower Range Value (4 mA) 0.000 m 479 mA
PV % of Range:
PV Damping Value 000 s 497%
Echo Lost Timeout 2 s NAMUR Setting: Disabled
Latching Mode Non-latching

9p Disconnected | G Device |il Offine Planning Engineer

ator

Figure 14: Basic Configuration - 4-20 mA Outputs

Lower Range Value (LRV):
The measured value of the Primary Variable for which the 4-20 mA loop current output
will be scaled to 4 mA. This value must be within the upper and lower limits for the
current Primary Variable, which will vary depending on the type of the variable (Level,
Volume, etc.).

It is possible to have a high Primary Variable value mapped to 4 mA if

Note: . S :
a reverse relationship is required.
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Upper Range Value (URV):

The measured value of the Primary Variable for which the 4-20 mA loop current output
will be scaled to 20 mA. This value must be within the upper and lower limits for the
current Primary Variable, which will vary depending on the type of the variable (Level,
Volume, etc.).

It is possible to have a low Primary Variable value mapped to 20 mA if

Note: . S .
a reverse relationship is required.

Damping (PV Damping Value):
Allows damping of the analog current output to filter out rapid fluctuations. The range of
the damping value is from 0 to 60 seconds, which represents one time constant (i.e.
response to step input reaches 63% of final steady-state value after the specified time
has elapsed), as per the HART specification. This damping is applied to both the digital
Primary Variable as well as the analog Loop Current.

When accessing the 4-20 mA Outputs page outside of the Guided Setup mode, the page offers
the additional options to adjust the following parameters:

Echo Lost Timeout:

The number of seconds that the transmitter will wait after the reflection from the product
has been lost before setting a critical alarm and entering failsafe (burnout) mode. The
same behaviour will result if instead of the measurement being completely lost, the rate
of change has been exceeded.

Latching Mode:

This parameter allows selecting the behavior of the GWR transmitter in case of a critical
error. If the Latching option is selected, the GWR transmitter will stay in the critical error
state until a user performs a hardware or software reset. If the Non-latching option is
selected, the GWR transmitter will leave the critical error state automatically, after the
circumstances leading to the critical state cease to exist and attempts to re-measure level
over the entire probe length.
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8.7.7 Summary

The Summary display is the last step of the Guided Setup mode and the last menu option on the
Basic Configuration menu. This display provides a tabularized list of the current value of all of the
parameters available on the Basic Configuration menu, as shown below in Figure 15. The DTM
ensures that each of these parameters have been read from the transmitter whenever this page is
opened, regardless if they were entered through the Guided Setup mode or not.

| Product Levei % (1)
Outst Uspe Rarge Vol [10%0
Output Lower Range Vae [0
PV Qampng Aooo-
Echa Lost Timeaut s
Latching Mode |Latchieg
SV Selection | Product Lew Rate )
TV Slecton Vapee Thickness % )
Qv Saiection | Vapor Thickness (4)
Distance Unz m
Tomprtuo Unt e
Lower Prodost Dviectsc Constant 100
Uppae Product Dislectsic Constant 11000
Vs Dictre Contae [1ow
Measured Products | Sngh Liawd
Maxmum Filng Rate 10.000 mvs
Sensor Height 200m
Maimom Product Lived 10020 m

+ [9pOisccanected | Q. Device | Ofine | Product Level % 0.000 | % Of Ravge 0.030 | Leop Current 0.000 mA | Plannng Engnest

Figure 15: Basic Configuration - Summary

In addition to the parameters from the Basic Configuration menu, the Summary display also allows
the parameters available from the
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Advanced Configuration menu (see section 8.8) to be included in the summary table. This can be
done by clicking the Show Advanced Settings checkbox in the top right-hand corner of the display.
When this option is selected, the DTM first checks to see if all of the Advanced Configuration
parameters have been read from the transmitter yet. If all of the Advanced Configuration displays
have not been visited, it is likely that the DTM has not read all of the parameters yet. In this case
the DTM will display the following message box indicating that it will take some time to read the
advanced parameters and provide the user with the option to cancel this operation.

Mote that not all of the Advanced Configuration parameters have been read
_ ~ from the transmitter. Click OK to start the process of reading these
| | parameters. Click Cancel to abort. If OK is clicked, a progress bar will
= become visible to indicate the progress. During this process, unselecting
the Show Advanced Configuration checkbox will abort the process.

0K Cancel

The Save to File button located at the bottom of the Summary display allows the contents of the
Summary table to be written to a text file. Before performing this operation it is advisable to turn on
the Show Advanced Settings option.

In the Offline Parameterization mode, the Summary display provides the added ability to read a
previously saved configuration file. Clicking on the Load from File button will allow the user to
browse for the desired configuration file. All the configurations stored in the file will be loaded into
the corresponding menu pages where they can be edited further and resaved to a file if necessary.
Once loaded into memory, the previously saved configuration can also be used to restore a
replacement transmitter. To do this, first close down the user interface, then use the FDT host
container’'s Connect and Load to Device options to download the configuration.
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8.8 Advanced Configuration

The Advanced Configuration menu items deal with fine tuning of the algorithms used inside the
transmitter and generally do not need to be adjusted. However, in demanding applications or if the
process or mounting configuration changed from what was ordered, some of the default options
may need to be adjusted.

8.8.1 Mounting

The main configuration parameters in this group deal with describing how the transmitter is
physically mounted to the tank, as shown below in Figure 16. The lower portion of the display
provides access to a number of advanced options and actions that may be necessary to fine tune
the transmitter performance in cases where the characteristics of the mounting cause
disturbances that cannot be modeled in the factory.

Basic Advanced Monitar Status Product Level 4-20mA
Configuration [EeSINTslENT] . oK 1.01m 121 mA

Honeywell
SmartLine Guided Wave Radar

Probe | Linearization | Wolume Correlation Algorithm | Services Local Display
Transmitter Model SLGT720: Standard
F
——
Process Connection Threaded I E

Sensor Connection
Mounting Location
Mounting Angle

Nozzle Diameter (F)

Nozzle Height (E)

Full Tank Detection
Amplitude Tracking

Background Type

Dynamic Background

Background Capture

Background Type

Background Length

Direct

Nozzle -

0.000 deg
0.100 m
0300 m
]
Factory -
13205 m

? Connected _E_l Device |/ Non-critical Alarms

Planning Engineer

Figure 16: Advanced Configuration — Mounting

Transmitter Model:
Read-only parameter reflecting the model of transmitter ordered, either SLG720 or SLG726.

Process Connection:
Read-only parameter indicating whether the transmitter was ordered with a flange for mounting to
the tank or with a simple threaded connection.
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Sensor Connection:

Read-only parameter indicating how the Sensor Housing and Process Connector are connected.
In most cases these two components are connected end-to-end in the Direct mount mode. For
harsh environments where the temperature at the Process Connector is too high for the
electronics inside the Sensor Housing, a 3 m Remote Mount cable is available to physically
separate the electronics from the process connector. When the Remote mount mode is used, the
transmitter will acquire a longer echo curve to cover the additional length of the Remote Mount
cable, and will use the process connector reflection as the datum point to find the transmitter’s
Reference Plane location.

Mounting Location:

This parameter allows users to select the option that best describes how the GWR transmitter is
located on the tank. The available selections are:

e Tank: (Mounted to a flat surface in the tank ceiling or wall)

e Bracket: (Mounted to a bracket over an open roof tank)

o Nozzle: (See transmitter specifications for limits on nozzle dimensions)
e Bypass: (See transmitter specifications for limits on bypass dimensions)
o  Stillwell: (Stillwell must extend beyond the length of the probe)

e Unknown: (To be used only if none of the above are applicable)

Selecting the Bypass or Stillwell options require an additional parameter entry to specify the
inside diameter of the bypass or stillwell. Selecting the Nozzle option requires two additional
parameter entries to specify both the inside diameter and length of the nozzle, as shown in
Figure 16.

Mounting Angle:
The physical angle at which the probe is mounted relative to vertical (O degrees means the probe
is perfectly vertical).

Full Tank Detection:

Full tank detection enables the detection of a level within the upper blocking distance at startup
and it ensures reliable measurement when the block distance high (BDH) is reduced below the
transition upper distance.

This feature enables the transmitter to perform additional analysis on the data in the region near
the reference plane where the product reflections become mixed with reflections from the physical
mounting components such as a flange or nozzle. This additional analysis allows the transmitter to
detect the presence of product in this region even if the shape of the product reflections deviate
significantly from the expected shape. This option should only be enabled if a recently captured
Field or Obstacle background is in use (see below) and the Dielectric Constant of the Upper
Product is above 12. It should not be enabled for products with low Dielectric Constants or when
the Factory background type is being used.

In a demanding application where measurements close to the process connector are required but
large temperature fluctuations are expected it is also recommended to enable Dynamic
Background updates as discussed below.
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Amplitude Tracking:

This feature enhances the sensor to track levels under dynamic conditions or when the radar pulse
attenuations in the media are not well known. Once the sensor has locked onto a correct level, it
will track the amplitude rather than use the initial (user specified) model amplitude. These values
are periodically permanently stored and are hence recovered after a power down. Stored values
are cleared and re-initialized to the user provided amplitudes by turning off Amplitude Tracking
(and applying this change) and then turning it back on it. Amplitude tracking is not a replacement
for setting correct correlation models and will not track pulses whose amplitudes differ more than
about 40% from the user specified pulse model amplitudes. It is recommended that amplitude
tracking is turned on when the attenuations are not well known or vary over time, such as in the
Saturated Steam application.

Background Type:

The physical components used to mount the transmitter to the tank will always cause some
reflection of the radar pulse as the pulse leaves the confines of the process connector and starts to
travel through the medium in the region near the reference plane. Depending on the configuration,
these reflections may appear very similar to the reflections from the products in the tank and
therefore should be ignored. In addition obstacles present close to the wave guide can cause
reflections that mimic levels. The SLG700 transmitter utilizes a means of subtracting out these
static background reflections before processing the data for reflections from the product(s).

All transmitters have pre-configured backgrounds for standard probe configurations which can be
selected with the Factory option. In all but the simplest applications, these should be replaced if
possible in-situ with one of the other two options using the capture mechanism described below.

e The Field option is meant to reduce the effect of the process connector reflection created
when the radar pulse traverses between two regions of different impedances. The preset
length varies from 1.32 m (standard temperature and pressure gauge) to 2.38 m (high
pressure high temperature model) from the measurement Reference Plane. The user
needs to ensure that the level in the tank is below these values when acquiring the
background. The field background is stored in permanent memory.

e The Obstacle option is similar to the field background but is intended to both suppress
process connector reflections as well as any false echoes generated by obstacles in the
tank (ladders, pipes, valves) in the vicinity of the probe. There is no limit on the length
that can be specified by the user. As with the field background, the level in the tank
needs to be about
30 cm below the end of the requested echo. One difference between the obstacle
suppression echo and the field background echo is that the sensor algorithms analyze
this echo and store only those sections of the profile that are found to contain false
echoes. For example, if a ladder exists 2m down a tank and a pipe inlet 19 m down the
tank, the user should obtain an obstacle echo up to approximately 20 m. The sensor will
automatically detect the two objects and permanently store the relevant data, omitting
quiet regions in between.

The active Background Type selection is independent of the capture Background Type described
below. New backgrounds are applied immediately once captured. However, it is not possible to
stay in obstacle mode after collecting a field type background because it is likely that the obstacle
background is significantly longer than the field background just collected. Normal operation is to
choose a background mode, apply, then collect a background in that mode. Backgrounds can be
verified on the Echo Curve display on the Monitor menu.
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Background subtraction is not available in the Saturated Steam

Note: P
application.

Dynamic Background:

The feature provides enhanced immunity against measurement conditions by dynamically
adjusting the active Field or Obstacle background profile. (This feature is not available for the
Factory Background Type.) With Dynamic Background enabled, the sensor periodically schedules
automatic updates to the background echo profile. Echoes are only updated if the level is outside
of the transition zones (see section 8.8.3) and the signal is of good quality. Data is collected up to
approximately 30 cm from the level at the time, if this distance is within the requested background
echo length.

The most recently updated background is also stored in permanent memory and is applied after a
sensor reset if dynamic background is enabled. At all times the sensor maintains a copy of the
original user acquired (static) background echo and will revert to this if the dynamic background
feature is once again disabled. Re-enabling dynamic background at that point starts the process
anew. Itis recommended that this feature is turned on in all installations where probe build-up or
large ambient temperature swings over 30° C are expected.

Background Capture: This group of controls provide the mechanism for obtaining new
background echoes for the Field and Obstacle background types described above. These controls
are only visible when no other parameters are being edited as the background echoes are
inherently dependent on the current mounting configuration. All edits must be applied or discarded
before a background capture may be started.

e Background Type: This control allows the user to select the type of background profile
that should be collected as either Field or Obstacle. (The Factory background profile is
completely static and cannot be captured or dynamically updated.) This type parameter
does not have to be the same as the active Background Type parameter described above
which is located outside this group of controls. In fact, a Field or Obstacle background
profile must be collected first before it can be activated.

e Background Length: This control allows the user to enter the desired length of
background profile to collect as measured from the Reference Plane. For the Field
background type the control will be automatically populated with a preset length based on
the current mounting configuration. The length cannot be increased beyond this preset
value and should only be lowered in extreme cases when it is not possible to bring the
surface of the product below this length. For the Obstacle background type the control will
also be automatically populated with this preset length but the value may be increased as
required to cover all obstacles, up to the measureable length of the probe.
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Start Capture:

This button activates the process of collecting a new background echo for the selected type and
length. This process should only be performed when there is no product in the region over which
the background will be captured. The length of this region varies with the transmitter model,
mounting location and probe type. A pop-up message similar to the one shown below will be
displayed indicating the required length.

The Field Background capture sequence should only be started when the
distance to the surface of the product in the tank is at least 132.000cm.
Confirm that this condition is met before proceeding

OK Cancel

If the OK option is selected, the transmitter will start the capture sequence and a progress bar will
be displayed to show the progress. The function of the button will also change, as shown below,
allowing the user to cancel the currently active sequence if required.

Cancel Capture | 2 |

Upon completion of the process, a pop-up message such as the one shown below will be
displayed indicating whether the capture was successful or not. In the case of a successful capture
there may also be some additional information or warnings provided. The new background is
immediately applied by the transmitter, but see the comments above for the active Background
Type parameter.

The requested Background Capture completed successfully

0 Additional Info:

Capture completed but the recorded background length is shorter than

recommended due to a short probe length
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8.8.2 Probe

The main configuration parameters in this group deal with describing how the probe, or
waveguide, that guides the radar pulse towards the bottom of the vessel is constructed, as shown
below in Figure 16. The lower portion of the display provides access to a number of advanced
options and actions that may be necessary to fine tune the transmitter performance in cases
where the characteristics of the probe are particularly important and cannot be modeled accurately
in the factory.

Honeywell

SmartLine Guided Wave Radar

Basic Advanced Monitar Status Product Level 4-20mA
Configuration Oy NENTG] OK 1.21m 121 mA

Mounting Probe Linearization | Volume | Correlation Algorithm | Services Local Display

Probe Type Rod -
Probe Diameter 16 mm © @
Probe Propagation Factor 1.00000 I[B) T‘T
Steam Reference Probe Type 50 cm - — -
Probe End Type MNone
Centering Disk Type None - .
Centering Disk Diameter 2" /45 mm
Probe Length (A) 10,000 m
1ECJ

Blocking Distance High (B} 0670 m
Blocking Distance Low (C) 0120 m
Blocking Zones Action Default Behavior i

Probe Length Calibration Steam Reference Calibration

=5 connected | Bl Device | €3 Critical Alarms Planning Engineer

Figure 17: Advanced Configuration — Probe
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Probe Type:

Only adjust this if you are changing the type of probe. Adjustments to the calibration offsets and
many other tuning parameters may be necessary if the probe is changed. The available options
are: Custom, Rod, Wire, Multi-Twist Wire, Coax and, with R200, FEP-coated wires and rod. Not all
probe types are compatible with both transmitter models (SLG700 and SLG726) and all
applications so some options may not be available.

Figure 18 — Wire Probe Types

The wire probe type comes in two different constructions, as shown in
Figure 18 above and it is important to select the correct one.

The Wire selection refers to the single-twist 1x19 construction which
consists of 19 individual strands twisted together in a single bundle with
a cable-like appearance.

The Multi-Twist Wire selection refers to the 7x7 construction which is
made up of 7 bundles, each consisting of 7 individual strands, which
gives it a more rope-like appearance.

Note:

If FEP-coated probes are used, it is important that the user makes the correct selection here — for
these types of probes, the RADAR pulse changes shape as it travels down the probe and this
requires activation of special algorithms in the sensor.

Revision 6 SLG700 Series HART Option User’'s Manual Page 101



Probe Diameter:

This parameter specifies the nominal diameter of the probe. In most cases, there is only one valid
diameter for a given transmitter model and probe type combination, so this parameter cannot be
changed from the default value. Currently the only exception is for a rod type probe attached to an
SLG720 transmitter, which can be ordered with either an 8 or 12 mm diameter.

Propagation Factor:

Propagation factor will be factory set for the probe type ordered. If the probe is changed or a
customer supplied probe is used, this value may need to be adjusted to scale the apparent
distance to product appropriately. Consult Honeywell for details.

Steam Reference Probe Type:

This parameter is only applicable for the Saturated Steam application and identifies the
length of the larger diameter rod installed at the top of the probe that provides the
additional Steam Reference reflection. The available options are None, 30 cm and 50 cm.

Probe End Type:
This parameter specifies how the probe is terminated. For Rod and Coaxial probes the only
available option is None. For Wire probes the available options are Clamp, Weight and Loop.

Centering Disk Type:

This parameter identifies if a centering disk is present and if so the material that it is made off. If
the centering disk was ordered with the transmitter this will be correctly set when the transmitter
leaves the factory.

Centering Disk Diameter:

If the Centering Disk Type is not set to None, an additional parameter is required to specify the
diameter of the disk. If the centering disk was ordered with the transmitter this will be correctly set
when the transmitter leaves the factory.

Probe Length:

This is a factory setting based on the purchase order. Adjustments to this parameter is only
required if the probe has been replaced or cut shorter. This parameter should always be measured
from the reference plane to the effective end of the probe. For a Coaxial probe and a Rod probe
without a centering disk, the effective end of the probe is the physical end of the probe. For a Rod
probe with a centering disk attached, the effective end of the probe is the top surface of the
centering disk. For a Wire probe with an end weight, the effective end of the probe is the top of the
end weight.

Blocking Distance High:

Blocking distances are areas of the sensor reading range where it is not desirable to search for
reflections, possibly due to poor signal to noise ratios. The Blocking Distance High is the distance
value measured starting from the Sensor Reference Plane. The transmitter will not attempt to
make a reading in this area. The factory-set blocking distance is set to the transition distance high.
It is recommended that the blocking distance is set to the largest value the measurement can
tolerate and that the loop current is adjusted to reach maximum before level reaches the blocking
distance. The minimum value for Blocking Distance High, as well as the transition distances is
shown in the table below.
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Blocking Distance Low:

Blocking distances are areas of the sensor reading range where it is not desirable to search for
reflections, possibly due to poor signal to noise ratios. The Blocking Distance Low is the distance
value measured starting from the Probe End. For a wire probe with an end weight, the end of the
probe is the top of the end weight. The transmitter will not attempt to make a reading in this area.
A minimum value is predefined by the factory to be the same as the Low Transition Distance.
The minimum value for Blocking Distance Low, as well as transition distances, is shown in the
table below

Blocking Zones Action:

This is the action to take regards to loop current when the surface or interface enters one of the
two low accuracy zones defined by the Blocking Distance Low and Blocking Distance High
parameters, as indicated in Figure 17. The Default Behavior option means that when in Blocking
Distance Low, set to Low Saturation, and when in Blocking Distance High, set to High Saturation.

Steam Reference Calibration

In Saturated Steam applications, this procedure calibrates the length of the Steam Reference rod.
This operation is critical for good level measurement since the apparent length of the rod at high
temperature and pressure is used to calculate the propagation speed of the radar pulses. Since
there is some tolerance in the mechanical mounting of the rod with respect to the process
connector, this operation is required after installation and before steam is applied to the bypass (or
coaxial tank) installation. The operation can fail if the correct rod length is not selected during set
up, if the reference and steam reference models are not correct or if the measured lengths are
significantly different from the default. Multiple measurements are made, averaged and stored to
the sensors permanent memory.

Probe Length Calibration

The probe length value is significant to the algorithm in two cases: when the level drops near the
bottom of the probe, the sensor must distinguish between the surface (or the interface reflection)
and that of the end of probe. The second case is when choosing Low DC measurement — in that
case the value of the probe length is part of the distance to the surface calculation and must be
known precisely. This procedure, which can only be carried out if the tank is empty, determines the
observed probe length by measuring the position of the end of probe reflection multiple times and
storing the result in permanent sensor memory.
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8.8.3 Transition zones

Transition zones are areas close to the process connector and close to the end of probe where
measurements have reduced accuracy, see table below.

For more information on transitions zones for the various sensor configurations (i.e. coax, rope,
rod, HTHP, Saturated Steam application, etc.), refer to SLG700 SmartLine Level Transmitter

User’s manual, #34-SL-25-11.

Table 21 - Minimum blocking distances and transition zones for the various probe

types
Minimum Upper Minimum Lower
Probe Media in Blocking Transition Blocking Transition
Type Tank Distance Zone, Tup Distance Zone, Tiow
High [cm] [cm] Low [cm] [cm]
. Water 9 13 0 1
Rod/Wire (DC=80)
Rod/Wire | Oil (DC=2) 7 14 0 12
Water 5 14 2 0
Coax (DC=80)
Coax Oil (DC=2) 5 8 6 7
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8.8.4 Linearization
This option allows users to adjust the level measurement to agree with a customer measurement.
It is available only through the use of a PC-based DTM / DD.

Configure the linearization table to make the transmitter output agree with an independent level
measurement.

Honeywell Bas ! | Honeywell Basic Advanced Mari Status Dendme 4.2
Smart Wave Rad Configuration @ | smartLine Guided Wave Rada: Configuration SSEITHIETTE A Offline 4.3 mj
Maunting Probe . Mounting Frobe Wolume | Comalation Algorithm |
Enable Linearization Enable Linearization | &7 Measured Level (m) Comected Level (m)
O
Linearization Timestamp 1972-Jan-01 00:00 2 | 10.000 10.000
Wet Linearization
Measured Leve 0.90 m |—|
Comected Lev T
Add Row || Inzert Row |
| Discard | | Apply
Linearization Disabled Linearization Enabled

Figure 19: Advanced Configuration — Linearization

The Level Linearization feature does not affect the values reported for
the Distance to Product and Distance to Interface device variables. If
Level Linearization checkbox is enabled, associated level are no longer
described solely by the basic geometry and it is possible that the
Product Level will not be equal to (Sensor Height — Level Offset —
Distance to Product). Likewise for the Interface if is being calculated.

Note:

Enable Linearization:

If enabled, linearization will convert the level as measured by the sensor to a corrected level value
as defined by the user in the linearization table on this page (max 32 points). This may be used to
correct for any non-linearity’s that may occur. For example, a tank for which the roof height
changes during filling.

Wet Linearization:

When the measured level for the tank reaches a level where the corresponding corrected level is
known, select a row in the linearization table, enter the corrected level in the textbox below, and
press the arrow button. This will immediately set the current measured level and the corrected
level into the selected row in the table (i.e. immediately set in the transmitter).

This feature is disabled when a user makes other changes
Note: on this screen. Apply or discard any other changes before
configuring Wet Linearization.
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8.8.5 Volume

While the SLG700 transmitter is generally used to measure the level of a product within a vessel, it
can also be used to estimate the volume of product that corresponds to that level. This feature is
turned off by default, but as shown below in Figure 20 through Figure 22, the calculation of volume
can be based on the geometry of the vessel or through a piece-wise linear mapping, often referred

to as a Strapping Table.

Honeywell e o
Sra e Gorsed Weve Radsr Conhguranon 43 mA

Volume Calculanon
Meod

Figure 20: Advanced Configuration: Volume Calculation — None
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Honeywell tomitc £ 20
S e Guided Wove Roda( - oK L3mA
Mountng | Prota earal Ohamé Corelation Algosthm Locd Display
V"MmqucM-km I6edd Tati Shage y
Tank Shagw Sphece
> Ua)
Tank Dlameter (A) 200 m
Volume Offget Q00 m
Drecard ] | Appty ]
Figure 21: Advanced Configuration: Volume Calculation - Ideal Tank Shape
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|y SLG700 HART Parameter | 46x
Distance to
Product
0.20m

420mA
48mA

Honeywell N Basic A
SmartLine Guiled Wave Radar €} | Configuration IS

Mounting l Probe l Lineanzation — Correlation Algorthm [ Services l Local Display

Volume Calculation ©  Strapping Table v
Calibration Timestamp Jan 1, 1900 00.00

Wet Volume Calibration ()

Measured Level 090 m
Volume 0.00] m*

Volume Offset 0.000 m?

Add Row ” Insert Row ]

(o ][

potor |

Figure 22: Advanced Configuration: Volume Calculation — Strapping Table

Wet Volume Calibration

When the measured level for the tank reaches a level where the corresponding volume is known,
select a row in the strapping table, enter the corresponding volume in the textbox below, and press
the arrow button. This will immediately set the values into the selected row in the strapping table
(i.e. immediately set in the transmitter).

This feature is disabled when a user makes other changes on
Note: this screen. Apply or discard any other changes before
configuring Wet Volume calculation
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8.8.6 Correlation Algorithm

The method by which the distance to product surface and distance to interface is found is based
on correlation between the measured echo curve and reflection models. The algorithm slides the
models across the echo curve, and at each step calculates the difference between the model and
the echo curve, referred to as the Objective Function. Typically the smallest value of the Objective
Function corresponds to the level selected by the sensor algorithms but the values must be below
a user defined threshold. In case of multiple local minima, there is additional logic to select the
best candidate. The final best candidate is used to calculate the distance to the product surface
and/or the distance to interface. Default threshold values are typically 0.5 to 0.6.

Figure 23 shows the DTM display used for configuration and troubleshooting of the algorithm.

Hoowywed
2266 oo 3=

Datssce = 33 om Oty Pencton » 519

Figure 23: Advanced configuration: Correlation algorithm screen

Different captured echo curves can be selected for analysis from the list in the upper right corner.

The upper graph displays the echo curve with the found reflections as well as the reflection models of
interest, i.e. surface reflection model. The bottom graph shows the objective function and its
threshold. Algorithm parameters are entered in the configuration section to the right of the graphs just
below the list of available echo curves.
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This section consists of 4 panels accessed through the combo-box pull-down control located at the

top of this section, as shown below in Table 22.

Table 22 - Algorithm parameters

Reflection Models v Attenuation Model

Surface - Vapor (/m)|0.0264
Width (mm) |94 = Upper Product 0.0540
()=
ion 1.127 =
Aftenuation anerF‘rDt(jJL;nc; 0.0540

Gain 4687 =

0Obj Function |0 500 =

-

Ak

Dielectric Constants

4

Vapor DC(1.0000 =

Upper Product =
De 2804000 (=

LuwerF’deug 60.0000 1=

Sensor Offsets -

Frocess
Connector |0.959
Offset (m)

Reference [ =
Flane Cffset (m) el

Threshold Calibration [j 5gg |2
Tuning 207.07 2 Offset (m) = s
Fosition
Steam
Reference |-0.590
These DC values will not be Offset(m)
written ta the transmitter!
(Use the Process page
instead)
The four Algorithm parameter panel details follow:
1. Reflection Models
2. Attenuation Model
3. Dielectric Constraints
4. Sensor Offsets
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Reflection Models
The radar impulse reflection model is an asymmetric damped cosine function that takes 3
configurable parameters as listed in the leftmost Reflection Models panel in Table 22.

The model and its gain, width and attenuation parameters are illustrated in Figure 24.

Amplitude
—

TN / Width \ Attenuation " |
\.\ / \ ///

Distance [cm)
Figure 24: Radar Impulse Reflection Model

e Gain: This parameter determines the magnitude of the central peak of the damped
cosine function.

e Width: This parameter determines the width of the central lobe of the damped cosine
function. It approximately equals the width between the zero crossings of the
function.

e Attenuation: This parameter determines how fast the cosine wave is reduced to zero
magnitude, and therefore determines the height and width of the side lobes to either
side of the central lobe. Increased attenuation results in smaller side lobes. Note that
the asymmetric property means that the side lobes will each have a slightly different
shape. This attenuation parameter should not be confused with the medium
attenuation that determines how the RADAR amplitude diminishes as it propagates
down the probe.

There is a total of 6 reflection models maintained by the transmitter to represent the types of
reflections that might be visible in an echo curve. These can be selected through the Reflection Model
pull-down selector under the Model tab shown in Table 22, and include:

e Reference e Surface
e Process Connector e Interface
e Steam Reference e End of Probe
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Note: Some of the selections may be disabled in the pull-down depending on the application and
mounting configuration.

The Reference reflection is a reflection caused by an impedance change where the transmission
line connects to the sensor board that generates the radar pulses. This reflection is always present
and its characteristic shape is not altered by any environmental or process conditions. In cases
where the sensor housing is directly connected to the process connector, the Reference reflection
serves as an internal datum point for locating the position of the transmitter’'s Reference Plane in
the echo curve.

The Process Connector reflection is a reflection caused by an impedance change within the body
of the process connection that provides the physical connection to the process. There are actually
a number of impedance changes in this section depending on the transmitter model and type of
connection, and therefore a number of reflections. The specific reflection of interest, if any,
depends on the application and hardware configuration.

One case where the Process Connector reflection is utilized is when the sensor housing is
separated from the process connector by the optional 3m Remote Mount Cable. Since the remote
cable may be subject to a high temperature gradient, its apparent length to the sensor may
change. In this case a reflection near the start of the process connector is used as the new datum
point for locating the transmitter’'s Reference Plane, eliminating temperature dependences of the
level measurement. The observed distance between this reflection and the standard Reference
reflection is dynamically updated as the Process Connection Offset.

Another case where the Process Connector reflection is always utilized is the Saturated Steam
Application. In this case, it is possible for high temperature steam to be present behind the
Reference Plane, which also impacts the apparent distance to the Reference Plane. In this case a
reflection near the end of the process connector is used as the datum point for locating the
transmitter's Reference Plane. For this application, the far reflection is used as the Process
Connector reflection, even if a Remote Mount Cable is in use.

The Steam Reference reflection model is used to describe the characteristic of the reflection from
the additional Steam Reference Probe which is only used in the Saturated Steam application. This
reflection is dynamically monitored to determine the change in the dielectric constant of the steam
as the pressure and temperature inside the boiler increases or decreases.

The Surface model is used to describe the characteristics of the reflection caused as the radar
pulse encounters the boundary between a vapor and a liquid product. The Interface model is used
to describe the reflection caused as the radar pulse encounters the boundary between two liquid
products. Refer to section 8.7.3 for a description of when each of these types of reflections may be
present.

The End of Probe model is used to describe the characteristics of the reflection caused as the
radar pulse encounters the physical end of the probe or a centering disk attached to the probe.
The shape of these reflections vary depending on the probe type and end treatment as well as the
transmitter model and other mounting considerations. While the physical end of the probe is
always present, depending on the transmission characteristics and amount of product(s) above the
end of the probe, this reflection may not be noticeable in an echo curve.
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Linear Attenuation Model

The gain (amplitude) of the radar reflection is exponentially decayed based on the linear
attenuation coefficient. This accounts for radar pulse energy dissipation to the vapor and media
surrounding the probe and is a function of the distance travelled. This is modeled as:

—-ax

Isurface (X) = gsurface(0)e

Where:
x = the distance from the reference plane
a = the linear attenuation coefficient

The linear attenuation of the gain is plotted in red in the upper graph in Figure 24. There is one
linear attenuation coefficient for each possible medium in the tank:

e Vapor
e Upper product
e Lower product
These are available on the Attenuation Model panel shown in Table 22.

For each possible medium in the tank there is also a reference point from which the linear
attenuation should be applied. For the Steam Reference, Surface and End of Probe reflections this
reference point is the transmitter’'s Reference Plane. For the Interface reflection, this reference
point is the location of the Surface reflection in non-flooded applications and the location of the
transmitter's Reference Plane for flooded applications. The Reflection Model panel has entry
fields where the locations of these reference points can be entered. In many cases, these
locations will have been determined by the transmitter and these entry fields will be pre-populated
with the correct values from the echo curve data.

Dielectric Constants

Under the Dielectric Constants tab, the user may enter the dielectric constants for the Vapor,
Upper Product, and Lower Product (not applicable for the Saturated Steam application). The user
can experiment with changing the DCs to see the effect on the derived gains that are automatically
re-calculated. Note that changing the DC values on this display does not actually send the new
values to the transmitter. Once the desired values are determined, the DC values must be
changed on the Process display and written to the transmitter.

Sensor Offsets

There are three offsets used by the algorithm in calculating the distance to surface measurement.
The Process Connector Offset (m) is only used for cases where the Process Connector
reflection is utilized (see the section on Reflection Models above), as it indicates the observed
distance between the Reference and Process Connector reflections. It is a calculated offset and is
therefore a read-only parameter. If the Process Connector reflection is not required for the current
application, this offset will default to zero.

The Reference Plane Offset (m) is a read-only parameter that is determined in the factory for each
transmitter. It corresponds to the distance between the physical reference plane and the internal
datum point, which is the location of either the Reference reflection or the Process Connector
reflection, depending on whether or not the optional remote mount cable has been ordered.

The Calibration Offset (m) is a user-entered offset that may be used to adjust for minor
inaccuracies in the distance measurements caused by differences between the factory and field
conditions. It has a range of +1.0m and is always treated as a vertical measurement, even if the
probe is mounted on an angle.
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The Steam Reference Offset (m) is a read-only parameter that is only available for the Saturated
Steam application. It is the distance between the Reference Plane and the Steam Reference
reflection as observed at normal atmospheric conditions, without steam.

Under normal circumstances, the only parameter that may require adjustment in the field is the
Gain parameter under the Model tab. The models which should be inspected for each application
type are listed in Table 23.

Table 23 - Models used for each application type

Application Reference Surface Interface End of Process Steam
Probe Connector Reference
Single Liquid | Yes Yes Yes Remote
mount only
Two Liquids Yes Yes Yes Remote
Flooded mount only
Two Liquids Yes Yes Yes Yes Remote
non-Flooded mount only
Saturated Yes Yes Yes Yes Yes
Steam
Single Liquid, | Yes Yes Remote
Low DC mount only
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8.8.1

Information on what triggers a Correlation Model Recalculation is summarized in Table 24 below.

Correlation Model Recalculation

Table 24 - Correlation Model Recalculation

Parameter recalculated

Parameters that will trigger
recalculation / reset required

Surface Model Gain

Vapor DC, Upper Product DC, Lower Product
DC, Measured Products, Probe Type,
Transmitter Model, Mounting Location, Sensor
Connection Type, Mounting Diameter

Interface Model Gain

Upper Product DC, Lower Product DC,
Application Type, Probe Type, Transmitter
Model, Mounting Location, Sensor Connection
Type, Mounting Diameter

End Of Probe Model Gain, Width, Attenuation

Probe Type, Probe End Type, Centering Disc
Diameter, Transmitter Model, Mounting
Location, Sensor Connection Type, Mounting
Diameter, Measured Products

Process Connector Model Gain, Width,
Attenuation

Transmitter Model, Sensor Connection Type,
Probe Type, Measured Products

Steam Reference Model Gain

Steam Reference Probe Type, Measured
Products

Propagation Factor

Transmitter Model, Probe Type

Vapor Attenuation

Transmitter Model, Probe Type

Minimum BDH/BDL

Vapor DC, Upper DC, Lower DC, Probe Type,
Measured Products

BDH/BDL

Vapor DC, Upper DC, Lower DC, Probe Type,
Measured Products

Steam Reference Model Width, Attenuation
and Threshold

Measured Products (Saturated Steam)

Vapor DC, Upper Product DC, Lower Product
DC

Measured Products (Saturated Steam)

Amplitude Tracking

Measured Products (Saturated Steam)

Field Background Type

Measured Products (Saturated Steam)

Mounting Location

Measured Products (Saturated Steam)

Mounting Diameter

Measured Products (Saturated Steam)

Probe Type

Measured Products (Saturated Steam)

Steam Reference Probe Type

Measured Products (Saturated Steam)
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8.8.2 How to configure the algorithm

Under normal circumstances, the transmitter will automatically find the level of the surface and
interface (if applicable) using the configuration that was shipped from the factory:

1.
2.

Step through the basic configuration and make sure that all entries are correct.

Review the Probe and monitoring parameters under Advanced Configuration and
ensure that all entries are correct.

Capture an echo curve as described in section 8.9.4.

Navigate to the Correlation Algorithm page and load the captured echo curve. Any
reflections that were located by the sensor in the echo curve will be identified in the
blue echo curve plot and the corresponding model will be placed at that location.

Select the reflection model that is to be tuned, either by clicking on the vertical
positioning line if the model is currently displayed in the graph, or by selecting it from
the pull-down to the right.

The selected model appears highlighted on the upper graph as a bold orange line to
distinguish it from the blue echo curve and the other unselected models.

Click on the vertical positioning line of the selected model and drag the model over
the relevant part of the curve. The example curve shown in Figure 25 below
represents a scenario of a two liquid non-flooded application with oil on top of water.
In the example the transmitter has correctly located the surface of the upper oil
layer, but has failed to find the interface boundary between the oil and water due to
a model mismatch. In this case the Interface model should be selected and dragged
to a location to the right of the Surface reflection where the interface is known to be.

The closer the model shape matches the curve shape, the lower the Objective
Function value, as shown in the lower right-hand corner below the bottom graph. In
the example, the brown Interface model does not match the blue curve at the
selected position (240 cm) so the Objective Function value is high (greater than 1).

{ Apphy
Dmncs = bifom Doy Femcion = L85

Figure 25: Adjusting the Correlation Algorithm
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Zoom view: Use the mouse to draw a zoom box around the model, then click and
drag the model position for best match to the curve. Notice that by dragging the
model over the similarly shaped blue curve at 338cm, the Objective Function value
has decreased from 1.004 to 0.658, indicating a higher correlation between the
shapes.

TIP: By slowly dragging the model back and forth over the curve you can
home in on the position with the lowest Objective Function value.

Amplitude

abjectve Functicn

Avallable Echo More

Curves

] | Giotal
Medel | Aferuation | DCs
Reflection Model

Inteface
Width () 124
Afteruation 1120 |2

Oain -5122

\ A/ | O Funclion a0 |5
- \ / Threshold
-4 \\J_r’
N . :ﬁ. m ) IZ..:.I..:nm\;_'m T e [ &
--
//' e
- S i — \\ / b " T — — ——— — —
- L/
itacs fonl I]lslan:::- 18 :m“:uu.Func‘lit;- 0858
Figure 26 Zoom View
10. Notice at previous step, the brown model line’s amplitude is slightly larger than the

blue curve’s amplitude. To reduce the model's amplitude to better match the blue
curve, decrease the Gain. By gradually decreasing Gain from 5122 to 3322 the
model more closely matches the blue curve while the Objective Function value has
improved from 0.658 to 0.580.

TIP: By using the up and down arrows to increase and decrease Gain you
can home in on the lowest Objective Function value.

11.

In the bottom graph of the Objective Function the red line indicates the Threshold.
The brown curve of the Objective Function must dip below this red Threshold line to
be recognized. If the Threshold is too low, increase its value to raise the red line
slightly above the dip as shown. Note that there should be only one dip that falls
below the Threshold line on the graph. If there are more than one, then the
transmitter may report incorrect position for the reflection. Recommended values of
the object function threshold are between 0.5 and 0.6. Higher values may cause
selection of the incorrect levels peaks. Lower values may not accommodate minor
pulse radar changes due to changing tank conditions.
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Objective Function

12. In most cases changing the position, Gain, and occasionally Threshold should fix
any problems with the echo reading. Click Apply to save your changes.

Note: In this example, the model mismatch was exaggerated to better
' illustrate the process. See step 14 for the final model parameters.

Fage Halp
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Curves

I 2016-kay-30 19.06:31 P
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Inferface.

Wi (mm) 124

Amenuation 1120 =
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Figure 27: Adjusting the Gain (Amplitude) Parameter

13. Next, go to Monitor and read a full echo curve. Check that the correct Reference,
Surface and Interface measurements were found.

14. If the algorithm is still not finding a match then the model’s other parameters, Width
and Attenuation, can be adjusted to get an even closer match between the model
and the curve. Note that it may be necessary to collect echo curves with various
levels of product to ensure that the reflection model provides a good match through
the full range. Figure 28 shows the example with the Gain, Width and Attenuation
parameters optimized to give and Object Function reading of 0.177.

4300 -

Glodal
Medel | Attenuation | DCs

1 | Renecton Moet

4 Interface

Gain 3822 F

Obj Function [pag0 =
Threshold

—
_H‘x/_x__-\‘_—f_- Width (mem) |8 3
14 Alteruation 1010 &
m D
Distinee fer)

an ™ [ iz ) i) 0 s i 0 a0 it [0 ) 1 ) 0 ™
Distancs o]

Distance = 338 cm 0. Function = 0477

Figure 28: Adjusting the Width and Attenuation Parameters
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In two liquid non-flooded applications, when the upper product thickness drops below 15cm
approximately, the surface and interface reflections start to overlap. The transmitter will continue
to measure the upper product thickness accurately down to 7 cm although the echo curve might
only show one reflection for both surface and interface. If the transmitter fails to measure
thicknesses below 15 cm or if the measurement of thin interfaces is inaccurate, it might be
necessary to adjust the reflection models as described above. However, to tune the surface and
interface models properly, a minimum upper product thickness of approximately 20 cm is required.

8.8.3 Tuning of linear attenuation

The linear attenuation for vapor will generally be correct for most applications and may not need
any tuning. However, the linear attenuation for the upper product will vary significantly from
application to application and the default value might not be appropriate. The upper product linear
attenuation describes how fast the radar pulse intensity decays with distance as it travels through
the upper medium. A precise upper product linear attenuation is therefore important in 2-liquid
flooded and 2-liquid non-flooded applications. A procedure to tune the upper product linear
attenuation is as follows:

1. Collect a minimum of two processed full echoes. One for a thin interface (20 cm) and one
for a thick interface (the thicker the better). Ensure that the interface level is away from
any disturbances that may affect the reflection amplitude.

2. Inthe Correlation Algorithm page, select the thin interface echo and place the surface and

interface models at the surface and interface reflection, respectively (if not already done

automatically).

Adjust the Interface model gain so the model matches the interface reflection

Select the thick interface echo and place the models appropriately

5. Adjust the upper product linear attenuation so that the interface model matches the
interface reflection

6. If the tuned interface gain and upper product linear attenuation provide a good model
match for interface for both echoes, click apply

how
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8.8.4 Services

The Services page provides access to many configuration settings and procedures related to the
maintenance and troubleshooting of the SLG700 transmitter. These features are organized into
several panels arranged in an accordion style container, as shown below in Figure 29.

Individual panels may be expanded or collapsed by clicking on either the panel’s title or the arrow
icon next to the title. A collapsed panel is indicated by a downward facing arrow while an
expanded panel is indicated by a right facing. Only one panel may be expanded at a time so
expanding a new panel will automatically cause the previously expanded panel to collapse. A
collapsed panel does, however, retain any edits made while it was expanded that were not applied

to the transmitter.

Basic

Honeywell

SmarilLine Guided Wave Radar

Advanced Monit Status Product Level 4.20mA
Configuration [ROSTE N vienitor 8.54m 17.7 mA

‘ Mounting | Probe

| Linearization | Volume Correlation Algorithm Services

%/ Diagnostic Logging

W DAC Calibration

Y Loop Test

¥ Installation Date and NAMUR Setting
WV Write Protection Settings
Y Device Locking

W Tamper Alarm Settings
v Perform Soft Reset

Y Reconcile Model Numbers
YV Reset NVRAM Corruption
Y Licensed Options

Y Reset to Factory Defaults

Local Display

=5 Connected | B Device | /%, Non-critical Alarms

Figure 29: Advanced Configuration — Services Menu

Planning Engineer
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Diagnostic Logging

The Diagnostic Logging panel, shown in Figure 30, allows diagnostic logging information recorded
by the transmitter to be uploaded and stored in a file for analysis by a qualified Honeywell expert.
The types of log files available are Startup, Live, and Error. Since some of the logs are very long,
once the reading of a log has been started, it may be cancelled at any time once the required lines

have been obtained.

[> Diagnostic Logging

Diagnostic Log Type

Live

Read

Clear

Save To File

Uptime: d:h:m:s 0000:00:26:42

GET_ECHO#1990

PlaceWin:FPScanlLenldx:1650
PlaceWin:Ref-Aroundldx:104,{0.219]
PlaceWin:NewScanWin[0,219]
PlaceWin:PlacedScanWin[0][0.219]
PlaceWin:ScanWin[0]:MergedWithFPWin:[0,1000]
PlaceWin:Surf:CalcWin:[300,800],MaxWin:[217,1699)]
PlaceWin:Surf-Final:Aroundldx:550.548828.{300,800]
PlaceWin:NewScanWin[250,850]
PlaceWin:IntersectsWithScanWin[0]:[0,1000]
PlaceWin:MergedScanWin[0]:[0,1000]
PlaceWin:ScanWindow{0]:[0,1000]

PROCESS_ECHO#1990, dT = 3.080905e-11
RefPeak:SearchPkPk: [73-145]

FindRefl: DeciSrch: 0 Indx:[105]: OBJVal: 0.159 Att: 1.000
FindRefl: DeciSrch: 1 Indx:[145]: OBJVal: 1.

m

Figure 30 Services — Diagnostic Logging
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DAC Calibration

The DAC Calibration panel provides a procedure for adjusting the slope (span) and offset (zero)
applied to the output of the Digital to Analog Converter circuitry, which is responsible for controlling
the amount of current flowing in the current loop. It is important that this analog current level
accurately matches the digital value that the transmitter has calculated to represent the value of
the Primary Variable, so that a control system reading the analog value will translate it into the
correct response. More detailed information about the overall procedure and the equipment
required can be found in Chapter 4. The layout of the DAC Calibration panel is shown below in
Figure 31.

[>> DAC Calibration

Enter Zero Trim Value Enter Span Trim Value
{4mA) read at multimeter (20mA) read at multimeter
4.0 ma 20,0 mA
Begin Set Set
Cancel Cancel

Figure 31 Services — DAC Calibration Panel

1. Clicking on the Begin button will automatically put the transmitter into Fixed Current
Mode at 4 mA. Make sure that any control loops monitoring the transmitter output
have been put in manual mode before starting this procedure.

2. The buttons and data entry field in the middle column will become enabled. Enter the
value read at multi-meter into the numeric data entry field, which should be close to
the 4.0 mA requested current. If it is significantly different, press the Cancel button to
abort the procedure and investigate the transmitter hardware further.

3. Click on the Set button in the Zero Trim column to allow the transmitter to adjust its
zero offset to remove any error in the 4 mA reading. This will automatically start the
next step in the sequence and put the transmitter into Fixed Current Mode at 20 mA.

4. The buttons and data entry field in the right-hand column will become enabled. Enter
the value read at multi-meter into the numeric data entry field, which should be close
to the 20.0 mA requested current. If it is significantly different, press the Cancel
button to abort the procedure and investigate the transmitter hardware further.

5. Click on the Set button in the Span Trim column to allow the transmitter to adjust its
slope to remove any error in the 20 mA reading. This will automatically put the
transmitter into Signaling Mode where loop current follows the calculated PV value.
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Loop Test

The Loop Test panel facilitates testing of the current loop wiring and connections right through to
the control system by allowing the sensor to be put into Fixed Current mode at any desired loop
current value between 3.8 and 20.8 mA (20.5 if NAMUR enabled). This is a step that is often
required as part of the Loop Check function during the commissioning phase, but it can also be
performed at any time after the transmitter is fully installed. The layout of the Loop Test panel is

shown below in Figure 32.

[> Loop Test

408

mA

Set

Exit

Figure 32 Services — Loop Test Panel

AP w bR

Installation Date and NAMUR Setting

Enter the desired loop current value in the numeric entry field.
Click on the Set button to put the transmitter into Fixed Current mode.
Steps 1 and 2 may be repeated as often as required.

Click on the Exit button to exit Fixed Current mode and put the transmitter into
Signaling Mode where loop current follows the calculated PV value.

The Installation Date and NAMUR Setting pane allows the setting of two unrelated configuration

parameters as shown below in Figure 33.

|> Installation Date and NAMUR Setting

Install Date: |01-Jan-1972 [~

NAMUR Enable

Figure 33 Services - Installation Date and NAMUR Setting

1. The Install Date entry field is for recording the installation date of the transmitter.
Note that the transmitter firmware only allows this date to be set once as it is the
datum point for the Time in Service and Service Life Remaining diagnostic values.

If the installation date has not already been set in the transmitter, the data entry field
will show the default date of January 1, 1972 and the control will be enabled.
Otherwise the configured installation date will be shown and the control will be

disabled.

2. The NAMUR Enable entry field enables or disables the NAMUR setting for the
transmitter’s loop current high saturation level. Enabling this will make the analog
output compliant with NAMUR standards, and will change the saturation output to
20.5 mA. Disabling this will change the high saturation output level to Honeywell’s

standard 20.8 mA.
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Write Protection Settings

The Write Protection Settings panel allows the configuration of the transmitter’s Software Write
Protection feature. This is a write protection scheme that can be enabled and disabled without
dismantling the transmitter and is in addition to the physical Hardware Write Protection feature
which can only be changed by opening the transmitter and moving a jumper. See the SLG700
Transmitter User’s Manual, Document #34-SL-25-11 for details. The Software Write Protection
setting is overridden if the Hardware Write Protection is enabled.

Figure 34 and Figure 35 below show two different views of the Write Protection Settings panel.
The first shows the panel as it is first opened when it is displaying the current setting of the feature.
Figure 35 shows all the data entry fields that are available on the panel for configuring this feature.
(The panel is not normally seen in this manner though, as the controls on the right-hand side are
only visible after the Change Password button is clicked and that button is not active while the
Apply and Discard buttons are visible in the left-hand side.)

[>> Write Protection Settings

Write Protection Enable Change Password

Figure 34 Services — Displaying Write Protection Settings

[>> Write Protection Settings

Write Protection Enable Current Password
Enter Password New Password
‘ Apply ‘ ‘ Discard ‘ ‘ Apply ‘ ‘ Cancel ‘

Figure 35 Services — Changing Write Protection Settings

1. Changing the Enabled or Disabled state of the write protection feature is performed
by simply changing the current state in the checkbox. The other controls then
become available to apply the new state to the transmitter. Note that write protection
can be turned from Off to On without providing a password, but the correct 4-digit
password must be entered in order to turn it from On to Off.

2. The 4-digit password required to turn the software write protection Off can be
changed by clicking on the Change Password button. The additional controls then
become available for entering the current and new passwords, which must both be
sent to the transmitter to complete the change.
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Device Locking

Device Locking is a HART 7 supported Common Practice feature that allows a HART master to
temporarily or permanently lock an instrument, preventing another master or the local operator
display from changing the transmitter’s configuration or calibration. The Device Locking panel,
shown in Figure 36 displays the current state of the transmitter and allows the user to apply a new
setting. The available options are Unlocked, Locked Temporarily and Locked Permanently. A
temporary device lock is automatically cleared whenever the transmitter goes through a power
cycle or a soft reset is performed. A permanent device lock is maintained through a power cycle or
reset and must be explicitly cleared by the master, either Primary or Secondary, which initiated the
lock.

[> Device Locking

Device Locking  Unlocked - ‘ Apply H Discard ‘

Figure 36 Services — Device Locking

Tamper Alarm Settings

The Tamper Alarm feature allows a warning to be generated if more than a specified number of
attempts or actual configuration changes are made, whether write protected or not. The warning
stays active until the specified latency period has elapsed after the Primary Master reads the
corresponding status byte. Examples of attempted configuration changes are moving the Write-
Protect jumper or entering a wrong password. The panel for configuring this feature is shown
below in Figure 37.

[> Tamper Alarm Settings

Tamper Alarm Enable

Max Allowable Attempts 3= Number of Attempts Counter 0

Latency (seconds) 15

Figure 37 Services — Tamper Alarm Settings

1. The Tamper Alarm Enable checkbox allows the feature to be turned On and Off.

The Max. Allowable Attempts entry field specifies the number of change attempts can
be tolerated before the non-critical status warning is generated.

3. The Latency entry field specifies the number of seconds, from 0 to 60, for which the
tamper alarm warning condition remains set after generated.

4. The Number of Attempts Counter indicator specifies the number of attempts to make
changes that have been detected since the warning condition was cleared.

5. Clicking on the Reset button will reset the Number of Attempts counter back to zero.

Revision 6 SLG700 Series HART Option User’'s Manual Page 125



Perform Soft Reset

The Soft Reset panel, shown in Figure 38, provides the ability to cause the transmitter to reset its
microprocessors. The resulting restart is similar to a normal power up sequence. The only
difference is if the Primary Variable is valid at the start of the reset sequence. If it is, the value will
be maintained until the initialization is performed, after which a new value will be sent out on the
analog output channel.

[>> Perform Soft Resat

Reset

Figure 38 Services — Soft Reset

Reconcile Model Numbers

The SLG700 transmitter maintains a copy of the unit’'s model number in both the Communication
Module and the Sensor Module. Under normal circumstances these are the same value, however,
if one of the modules is replaced there can be a mismatch between the model numbers, which
identifies the components configured. In this case, an alarm condition will be generated.

The Reconcile Model Numbers panel, shown below in Figure 39, displays the Model Key and
Model Number in both the Communication Module and the Sensor Module. In the case of a
mismatch, buttons become available next to each model number, allowing the user to select the
Model Key/Model Number pair to be used to update the transmitter. The Model Key/Model
Number from the selected component will be written to the other component.

[> Reconcile Model Numbers

Model Key - Model Number in Communication Module
l Use Comm Module Model Number | SLG720- - SLG720-SWAWSG6VMO01400-DS4A-0-BHE-1001S-A-1A7-00-IKRYM

Model Key - Model Number in Sensor Module
| Use Sensor Module Model Number ‘ SLGT720 - SLGT720-SWRWN00M01400-AS1A-0-BHJ-1001S-A-1A7-00-1KRYM

Figure 39 Services — Reconcile Model Numbers
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Reset NVRAM Corruption

The Reset NVRAM Corruption panel, shown below in Figure 40, displays the current status of the
NVRAM Corrupt flag for both the Communication Module and the Sensor Module. In the case of a
corruption the corresponding indicator will be red and a Reset button will be available to allow the
user to attempt a reset of the appropriate NVRAM. Note that this will cause default values to be
used and should be done only in rare occasions.

[> Reset NVRAM Corruption

{» Communication Module NVRAM

# Sensor Module NVRAM Basa

Figure 40 Services — Reset NVRAM Corruption

Licensed Options

Starting with the R200 release of the transmitter, certain firmware features require a license for
them to be activated. Normally these features will be purchased and licensed when the transmitter
is first purchased, however, there is also the possibility to purchase new features and relicense the
transmitter after it is installed. Check with your Honeywell representative for more information on
this feature.

The Licensed Options panel, shown in Figure 41, displays the currently enabled Licensed Options
and allows the entry of a License Key to enable newly purchased options.

[>> Licensed Options

Currently Licensed Options: Enable New Options
- Interface Measurement T
. i Appl
- Saturated Steam Application License Key pey

- Low DC Application

Figure 41 Services — Licensed Options

Reset Factory Defaults

The Reset Factory Defaults panel, shown in Figure 42, provides the ability to reset all device
configuration to the factory defaults, and trigger a soft reset. This will overwrite any configuration
changes made since the transmitter left the factory and should only be done to recover a corrupted
transmitter. The user will be prompted for confirmation before this action is taken.

[> Reset to Factory Defaults

Reset

Figure 42 Services — Reset Factory Defaults
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8.8.5 Local Display

Configure global settings and up to 8 screen formats of the transmitter’s display.

) COM7 = Parameter wgy SLG700 HART # Parameter

Honeywell _ Basic Monitor Status
SmartLine Guided Wave Radar §) Configuration SETIEEITT 0K
Mounting Probe l Lineanzation [ Volume Comelation Algorithm
Global Settings

Display Type Advanced Configured Device Type SLGT700
Language Pack Westem Display Password 0000
Display Language English v Screen Rotation ON
Display Contrast 5 - Rotation Time (3 to 30 secs) 10

Screen Settings

4.20mA
21.5mA

Services

Passward

Screen Number 1 (2
Screen Format PV > Trend Duration (hrs)
Variable to Display Distance to Product - Trend Low Limit
Display Units cm - Trend High Limit
Number of Decimal Places 2 . Custom Tag
Figure 43 Local Display Configuration
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8.9 Monitor

8.9.1 Dashboard

Configuration |

Dashboard Device Status & Alarms l Device Info Echo Curve

Measurement

Honeywell Basic l ;

Product Level Product Level % Product Volume
100%

1.03m 8598% 7.53m® 0.58m

™ \;:::s’ 4.20mA Qutput
ICl
2.905ft 20.54 mA
Level
10321 = e
° 7.64 US gal
Alarms » Advanced Diagnostics
i Signal Quali ignal Strength Internal Electronic
Critical bju « o »Sm} ) e Temperature
None Suracs sy
~ 05 -~ 90940
Non-Critical
2 Non-critical Alarms » 251 °F

L.

Figure 44: HART DTM Dashboard

The dashboard displays the current state of the system, including the state of the transmitter and
the associated readings and number of active alarms. When the saturated steam application is
being used, the dielectric constant of the steam will also be presented.

Signal Quality:

This variable indicates the degree of match between the reflection model and the live echo curve
data. This value is 1 minus the objective function value (see section 8.8.6) and values close to 1
represent a very good match. If this number drops too low the reflection models should be
checked as described in section 0.

Signal Strength:

This variable indicates the amplitude of the indicated reflection. The level and interface reflections
are negative; therefore, a lower higher value indicates a larger amount of the radar energy was
reflected which should provide a good signal to noise ratio. If this value drops too low the
transmitter may not be able to reliably track the associated level. A good reflection should be
approximately the same size as the gain for the correlation model peak: the acceptable values are
dielectric constant and range dependent. Good values are in the range between -500 and -9000
counts.

When the tank is empty or nearly empty, the reported Signal Strength and Signal Quality for
Surface and Interface will instead be the ones for the End of Probe reflection.
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8.9.2 Details Status and Alarms.

sy SLGT00 HART Parameter

Dashboard

B Critical Status/Alarms
Active Alarms

Sensor Critical Faiure
| Primary Vanatie Bad

Non-Critical Status/Alarms
Active Alarms
Sensor Noa-Critical Fadure
Device Vanable Out of Range
Sensor net Cakbvated
Surdace Signal Strength Bad
Surface Signal Quaity Bad

pDisconnected | § Device @ Offline

Device info Echo Curve

Description (Cause)

Resolution (Steps to take)
This is 3 rol-up status bt that is set when any of the following cntical status
| conditions are present
- Power Accumedator Fault
- Primary Vanabie Bad
- Sensor Board Oscillstor Failure
- Sensor Code Flow Fault
- Sensoc External RAM Fadure
- Sensor intemal RAM Failure
Sensoe Flash CRC Faslure
- Sensoc in Factory Mode
» Sensor in Low Power Mode
- Sensor Power Supply 2 5V Fault
- Sensor Power Supply 2 5V OSC Fault
Sensor Power Supply 3.3V status Fault

Refer 1o the resokstion for each condition

Description (Cause) Resolution (Steps to take)
Ths is 2 rollup status bt that is 5ot when any of the following non critical status
conditions are present
- Sensor Electronic Over Temparature
- Distance in blocking higher zone
- Distance in blocking lower zons
Sensor Not Characterized
- Sensor Nt Cahibrated

Refer to the resolution for each conditson

Figure 45: Device Status & Alarms screen

Planning Engineer

The Device Status & Alarms screen displays all active critical and non-critical alarms. The
blanker the screen, the better the health of the system. For a description of all of the conditions
that may appear on this display, refer to Section 6.2.

For any active alarm, follow the instructions in the Resolution column to clear the alarm.
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8.9.3 Device Information

The Device Info screen displays the current revision numbers of the software, hardware, install

date and so forth.

sy SLG700 HART Parameter pX
Honeywell s Advanced S Status ooy L 20mA
SmartLine Guided Wave Rada 0 on | Configuration NONOL oK y A 48mA
HART Protocol Revision Software Revision
7 2
Device Revision Hardware Revision
2 G
Comm. Firmware Revision DTM Revision
1.010000 1.010000
Display Firmware Revision
1.010000
Sensor Firmware Revision
1.010000
Device 10z 1234567
Model Number: SLG72X
Date s ization Date
YRIMTHIDAY HRIMIN/SEC ~ YRIMTHIDAY HRIMINISEC
dpDisconnected | § Device |l Offine Planning Engineer
[ator
Figure 46: Device Info screen
T - . s
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8.9.4 Echo Curve
The Echo Curve display allows users to capture echo curves for commissioning or troubleshooting

purposes.

Start Distance

End Distance

Units

Show Behind Reference Plane: to select a region.

Resolution: to select the resolution to select the resolution of the data collected
(impacts upload time)

Read and Clear to plot data.

Save To File / Open File: Allows users to save to disk and later perform analyses on
the data or send for offline analysis by experts.

The Honeywell SLG700 captures four types of echo curves:

Honeywell Basic Advanced Monior status i 420mA
SmartLine Gukded Wave Radar Configuration | Configuration ey 12.9mA
D | Dercemie
Echo Curve Type Start Distance End Distance Units  Resolution Units Read Saveto File
Processed (Ful) Echo Curve 0.00% 1200002 em 048] [om
i Clear Open File
] Show Behind Reference Piane 7] Use Sample Resolution
[] Show True Distances on Stem Plots Right click on each legend item for options.
T T T T : T T T T T T T T T T T T T T T T T T T T
so00 -
sooo -
700
soao|
sooo -
<000l
o ol
£ o
1000
ofil o P -
1000 - Lf
Surface at1000.121cm (Observed)
2000
a0
000
| \ , , \ , , , , , , , , , , \ , , , , \ . , , ,
o s w0 w0 w0 2 a0 w0 w0 a0 50 7o 7o s 0 se0 0 w00 s meo | ns w200

Echo Curve Type: Processed Full

o 00 650
Distance [cm]

&% Connected | B Device |2 Non-critical Alarms

Planning Engineer

Figure 47: Echo Curve screen
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Amplitude

Echo Curve Types

Windowed Echo Curve: In this echo curve type, data is shown only in the areas where the
transmitter is currently searching for reflections. On short probes (about 5 m depending on present
location of the level and process connector type) this will cover the full length of the probe but on
longer probes where the transmitter tracks the surface/interface reflections as they move, there will
be areas with no data visible. Subtraction of background reflections near the reference plane has
been applied to this data array so unwanted reflections, due to a nozzle for instance, will not be
visible. This type of echo curve is useful for troubleshooting the Correlation Algorithm settings as it
represents the data on which the correlation algorithm works.

so00 |
> Reference at -121.5402m (Qbserved)

8000 |-

6000 [

5000 |-

000 [

¥ Surface at999.845cm (Observed)

1 L L 1 L L 1 L L 1 L L L I
100 o 100 200 300 00 500 500 700 200 300 1000 1100 1200
Echo Curve Type: Windowed Distance [cm]

Figure 48: Windowed Echo Curve
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Full Echo Curve: This echo curve type includes data collected over the full length of the probe.
Subtraction of background reflections near the reference plane is not applied so all physical
reflections, due to a nozzle for instance, will be visible. This type of echo curve is useful for
troubleshooting problems in the region near the reference plane. Note that for longer probes, the
data shown on this echo curve was collected over multiple echo scans.

¢ Reference at -121.5402m (Observed)

Amplitude

-1000 |-

(¥ Surface at 1000.124cm (Observed)

2000 |-

3000 [

000 |-

L

1000 -
oF Y W /V\\,\,VMW,_

L L L L L
100 [] 100 200 300 400

Echo Curve Type: Full Distance [cm]

Figure 49: Full Echo Curve

Note: A Full Echo Curve will likely take much longer to capture than a Windowed
Echo Curve.

L L L
600 700 800 300 1000 1100 12
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Amplitude

Processed Full Echo Curve: Similar to the Full Echo Curve type, but with subtraction of

background reflections near the reference plane applied. This type of echo curve is useful for
process and/or algorithm troubleshooting.

8000

7000

5000

4000

3000

.

Reference at -121.540zm (Observed)

T T T T T T T

SN AS N

( Surface at1000.184cm (Observed)

-100 0

Echo Curve Type: Processed Full

. ,
200 300 400 500 500 700 300
Distance [cm]

Figure 50: Processed (Full) Echo Curve

Background Subtraction Array: Selecting this echo curve type allows the data array that is used
to remove unwanted reflections in the region near the reference plane to be uploaded and viewed.
This type of echo curve is useful for troubleshooting problems in the region near the reference

plane and checking whether any obstacles (if present) are found at expected locations.

Amplitude

9000

8000

6000

5000

4000

3000

2000

1000

-1000

2000

3000

4000

T T T T T T T T T T

4 Reference at -121.540cm (Observed)

L L L
160 140 120
Echo Curve Type: Background

L
-100

. .
20 =0 40 20 o 20 %0 50 50 100 120
Distance [cm]

Figure 51: Background Subtraction Array
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9 Security

9.1 How to report a security vulnerability

For submission, a security vulnerability is defined as a software defect or weakness that can be
exploited to reduce the operational or security capabilities of the software or device.

Honeywell investigates all reports of security vulnerabilities affecting Honeywell products and
services.

To report potential security vulnerability against any Honeywell product, please follow the
instructions at:

https://honeywell.com/pages/vulnerabilityreporting.aspx

Submit the requested information to Honeywell using one of the following methods:

« Send an email to security@honeywell.com.

or

 Contact your local Honeywell Process Solutions Customer Contact Centre (CCC) or Honeywell
Technical

Assistance Centre (TAC) listed in the “Support and Contact information” section of this document.
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Glossary

AWG American Wire Gauge

di Inside diameter of pipe

DD Device Description

EDDL Electronic Data Description Language

DTM Device Type Manager

EMI Electromagnetic Interference

FTA Field Termination Assembly

Hz Hertz

LRL Lower Range Limit

LRV Lower Range Value

mA DC Milliamperes Direct Current

mvV Millivolts

Nm Newton'meters

NPT National Pipe Thread

NVM Non-Volatile Memory

PM Process Manager

PV Process Variable

PWA Printed Wiring Assembly

RFI Radio Frequency Interference

RTD Resistance Temperature Detector

SFC Smart Field Communicator

STIM Level Transmitter Interface Module

STIMV IOP Level Transmitter Interface Multivariable Input/Output Processor

URL Upper Range Limit

URV Upper Range Value

us Universal Station

Vac Volts Alternating Current

Vdc Volts Direct Current

HART Highway Addressable Remote Transducer

HCF HART Communication Foundation

EEPROM Electrically Erasable Programmable Read Only Memory
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